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Welcome Message

On behalf of Institute For Engineering Research and Publications (IFERP) and
in association with Sinhgad College of Engineering, Pune, Maharashtra. | am
delighted to welcome all the delegates and participants around the globe to
Sinhgad College of Engineering, Pune, Maharashtra for the “International
Conference on Ubiquitous Computing 2017 (ICUC-17)” that will take place from
25" - 26™ July'17

Transforming the importance of Engineering, the theme of this conference’s
assembling is “International Conference on Ubiquitous Computing 2017
(ICUC-17)”

It will be a great pleasure to join with Engineers, Research Scholars, academicians
and students all around the globe. You are invited to be stimulated and enriched by
the latest in engineering research and development while delving into presentations
surrounding transformative advances provided by a variety of disciplines.

| congratulate the reviewing committee, coordinator (IFERP & SCOE) and all the
people involved for their efforts in organizing the event and successfully
conducting the International Conference and wish all the delegates and participants
a very pleasant stay at Pune, Maharashtra.

(LA

Mr. R. B Satapathy
Director
IFERP




The “International Conference on Ubiquitous Computing 2017 (ICUC-17)” is being
organized by Sinhgad College of Engineering, Pune, Maharashtra, India in association
with IFERP - |Institute For Engineering Research and Publications on the
25" - 26" June'17

Sinhgad College of Engineering, Pune, Maharashtra has a sprawling student - friendly
campus with modern infrastructure and facilities which complements the sanctity and
serenity of the divine city of Pune, Maharashtra

With blessings of Dagdusheth Ganpati, Pune, Maharashtra the “International Conference on
Ubiquitous Computing 2017” (ICUC-17) was a notable event which brings academia,
researchers, engineers, industry experts and students together.

The conference will be a perfect platform to share experience and foster collaborations across
industry and academia to evaluate current and emerging trends across the globe which were
given the international values by “Institute For Engineering Research and Publication
[IFERP]”.

The International Conference attracted over 135 submissions. Through rigorous peer reviews
77 high quality papers were recommended by the Committee. The Conference aptly focuses
on the tools and techniques for the developments on current technology.

We are indebted to the efforts of all the reviewers who undoubtedly have raised the quality of
the proceedings. We are earnestly thankful to all the authors who have contributed their
research works to the conference. We thank our Management for their wholehearted support
and encouragement. We thank our Principal for his continuous guidance. We are also
thankful for the cooperative advice from our advisory Chairs and Co chairs. We thank all the
members of our local organizing Committee, National and International Advisory
Committees.

ICUC - 2017
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PRESIDENT

Prof. M. N. Navale

Founder President, STES, Pune

MESSAGE

It gives me immense pleasure that the Sinhgad College of Engineering, Pune is
organizing International Conference on Ubiquitous Computing (ICUC) - 2017, in
association with Institute for Engineering Research and Publication (IFERP). Ever since
the inception of our institute, we have been striving for excellence in various departments of
Engineering and at the very same time marching forward with the mission of professional as
well as technical development.

| believe in promoting events to be organized in STES which opens research and innovation
avenues for students. ICUC-2017 is one such step towards motivating researchers and
practitioners. The conference greatly encourages under-graduate and post-graduate students,
research scholars and faculty to present innovative ideas and latest discoveries in the field
ofComputer Science and Information Technology engineering.

| take this opportunity to extend my best wishes to all the participants of this conference for
their future endeavors and also aspire that more and more people opt for research and bring
laurels to themselves and to the field of education.

PROF. M. N. NAVALE
President




SECRETARY

Dr. (Mrs.) Sunanda M. Navale,

Founder Secretary, STES, Pune.

MESSAGE

Education in general and technical education in particular, must be relevant to rapidly
changing needs of the industry and business houses. The educational environment must be
dynamic and quickly adaptable, so that professionals must be capable of shouldering local
and global responsibilities in industrial and social sectors.

This international conference brings together leading researchers and educators of various
domains to participate, contribute and explore their technical abilities and share theirviews.l
am confident that this souvenir will be useful to researchers and academicians to enhance
their knowledge on the research topics of their field of interest.

| am very much thankful to Institute for Engineering Research and Publication (IFERP)
for organizing ICUC-2017 in association with Sinhgad College of Engineering, Pune. I
express my sincere thanks to all well-wishers for their valuable guidance and unstinted
support, who have been directly or indirectly involved in the organization of this conference

Dr. (Mrs.) SUNANDA M. NAVALE,
Secretary




VICE PRESIDENT (HR)

Mr. Rohit M. Navale,

Vice President (HR), STES, Pune

MESSAGE

This year, Sinhgad Technical Education Society is celebrating its 25th year of
existence and, | am very glad to know that the Sinhgad College of Engineering, Pune is
organizing International Conference on Ubiquitous Computing (ICUC) - 2017.

The conference proceedings is a collection of abstracts of research based articles and papers
presented by under graduate, post graduate students and research scholars from the faculty of
Computer Science and Information Technology engineering.

These articles not only handle various issues in the field of Computer Science but also touch
an array of emerging trends from Information Technology like artificial intelligence and
ubiquitous computing. Conducting a conference of this magnitude is always encouraging and
| would appreciate the efforts of the college in this endeavor.

| hope that the conference will provide a platform for various personnel to introduce
innovative ideas and thoughts and exhibit their research skills in the field of Computer
Science and Information Technologyfor sustainable development.

Mr. ROHIT M. NAVALE
Vice President




VICE PRESIDENT (ADMIN)

Mrs. Rachana M. Navale — Ashtekar,

Vice President (Admin), STES, Pune

MESSAGE

Education is an instrument to enhance the capabilities of human beings to become
knowledgeable, creative and good citizens which has urged me to develop an excellent
educational facility at STES.

| am happy to know that the Sinhgad College of Engineering, Pune is hosting ICUC-2017.
It is a justified gesture to provide a platform for under graduate, post graduate students and
researchers to present their work and seek experts’opinion that provides insight in the work
undertaken.

| hope that the presentations, discussions, appreciations and suggestions will help in
improving their research work.l extend my heartfelt wishes to all the participants who have
contributed in making this international conference a great success.

Mrs. Rachana M. Navale — Ashtekar
Vice President (Admin), STES, Pune




PRINCIPAL

3l
Dr. S. D. Lokhande

Principal, SCOE, Pune

MESSAGE

It gives me pleasure to write for the proceedings of ICUC-2017 organized by Sinhgad
College of Engineering, Pune.

One of the main motive behind organizing such international conference is to evaluate the
research work of under graduate, post graduate students and enhance the quality of the
project reports, dissertation to be submitted to Savitribai Phule Pune University,
Pune.Conferences of this magnitude help the under graduate, post graduate students and
researchers to interact amongst themselves as well as experts in various areas. | feel that, with
presentations and interactions with experts; students are exposed to the emerging trends in
respective domains and the research work being carried out.

I would like to congratulate participants for contributing to this conference. | appreciate
conference conveners, faculty coordinators, staff members and students of Sinhgad College
of Engineering, Pune for organizing the ICUC-2017.

Dr. S. D. LOKHANDE
Principal




Convener

e
Prof. G. R. Pathak,

Head, Department of IT
Convener

MESSAGE

Sinhgad College of Engineering, have organized an International Conference on
Ubiquitous Computing (ICUC) - 2017, after organizing two consecutive international
conferences in recent past. The major objectiveof this conference is to provide a common
platform to academicians, researchscholars and students from India and abroad to share their
ideas & researchexperiences in various aspects of Computer Science and Information
Technology.

The purpose of this conference is to bring togetherresearchers, experts from industry,
academia, and other interested organizations to meet, exchangeinformation and ideas in
developments in the field of Ubiquitous Computing. It bringstogether the newest
developments in new computing related technologies; engineering solutions, andacademic
research results. The conference program has been designed to provide ampleopportunities to
researchers to network and to share ideas and information about the ubiquitous computing.

I hope this conference ICUC-2017 will be enjoyable, memorable, and productive
forparticipants and looking forward to the technological innovations that result from your
networking and discussions.

We are extremely thankful to our management, Keynote speaker, advisory committee
members, participants, reviewers, session chairs, organizing committee members and all
those who have helped us to organize this International Conference to make it a success.
Moreover such an event is notpossible without the hard work of the reviewers, to whom | am
deeply indebted for their timeand professional opinions on the submissions.

| extend my best wishes to the organizing secretary and all the members oforganizing
committee to achieve a grand success in the conference.

Prof. G. R. PATHAK
Head, Department of IT
Convener, ICUC-2017
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Mr. Deepak Mane

Big Data Consultant/Architect
TCS - Tata Consultancy Services
Pune,Maharashtra, India.

Message:

I welcome you to the “International Conference on Ubiquitous Computing 2017 (ICUC-17)”.
The event is going to be held on 25" — 26™ July 2017, organized by IFERP - SCOE, Pune. The ICUC -
2017 provides an opportunity to research scholars, delegates and students to interact and share their
experience and knowledge in technology application. ICUC -2017also provides an excellent international
forum for sharing knowledge and results in Recent Challenges in Engineering Technology. The aim of the
Conference is to provide a platform to the researchers and practitioners from both academia as well as
industry to meet the share cutting-edge development in the field.

Institute For Engineering Research and Publication (IFERP) is India's one of the largest
professional Organization meant for research development and promotion in the field of engineering and
technology. IFERP is a paramount body which has brought technical revolution and sustainable
development of science and technology. The IFERP-forum constitutes of professional wizards and
overseas technical leaders who have left no stones unturned to reinforce the field of science, engineering
and technology.

ICUC -2017was fortunate to attract a high interest among the community, and the high number of
submissions provided an excellent opportunity for a high-quality program, but also called for a
demanding and laborious paper evaluation process. The main program of ICUC -2017covers two days
and includes streams of parallel sessions. The program is further enriched by keynote presentations
offered by world-renowned researchers in the field. | am grateful to all authors who trusted us with their
work; without them there would be no conference.

The final result would not have been possible without the dedication and hard work of many
colleagues. Special thanks are due to the Track chairs, Session chairs, the members of the Technical
Program Committees, the General Chair, and to all external Referees for the quality and depth of the
reviews, and their sense of responsibility and responsiveness under very tight deadlines. . Thank you all.
We hope that the proceedings will serve as a useful reference of the state-of-the-art in application-specific
systems research.

Biography:

Mr. Deepak S. Mane is a Big Data Consultant/Architect in Analytics and Intelligence group at
Tata Consultancy services Since 2006. In his previous role he was Scientific Officer at Tata Research
Fundamental Research (TIFR). He has published 18 papers in Conference Seminars, and has been
conducting Seminar/workshop at various colleges in Maharashtra and MP under AIP/FDP activities -
TCS . He's also a mentor for KreSIT, Indian Institute of Technology - Mumbai. He is currently pursuing
research in Big Data , Analytics in Uniquitous Computing and Cloud computing

About Mr. Deepak Mane
Trainer - Cloud Computing , Big Data , Data mining , Mobile Computing, Ethical hacking at
AIP and FDP , TCS

He conducted workshop and seminar on following topics.
* Cloud Computing
* Big Data




* Data mining

* Mobile Computing

» Ethical hacking

* Performance Management
* Performance Engineering
» Amazon Web Services

* Disaster Recovery

Performance , Big Data and Cloud Consultant @ TCS at Tata Consultancy Services

* Openstack High Availability implementation - selected for Cloud connect conference 2013
* Autodeployment of openstack using Dodai and pacemaker

» autoscaling of nova compute nodes

» Multinode deployment of openstack in AWS

* Performance monitoring framework using munin

» Disaster Recovery of Openstack

Experience - Big Data

» Hadoop Cluster Management

* Performance testing and Performance benchmarking of HadoopCluster , Map Reduce program
* Disaster Recovery of Hadoop Cluster

* Performance Monitoring and Alert System for Hadoop Cluster

* Private Cloud setup using Eucalyptus for Hadoop

* Capacity Management of Hadoop ,Hbase and HIVE

* Data Archival process of Hadoop Data.

* AWS Elastic Map Reduce.

Mr. DEEPAK MANE




Manojsingh Chouhan

Biography
About:

Worked in India, Middle East and the UK for 20 + years in business development and Operations
Management, Market Intelligence and Strategic Alliances. Experience in devising GTM strategies,
International Business development, Budgeting, Forecasting & Planning, Key Account Acquisition
and Retention, Cross- Functional Leadership, Customised solutions for Smart City, Safe City, Data
Centres, Hospitality, Critical Infra, BFSI, Healthcare, Manufacturing, Real Estate, Oil & Gas, Utility
verticals.

M.Sc. in Applied Electronics with Distinction - 1st Merit holder from Amravati University, India
M.B.A (PGDBA) - Operations Management from Symbiosis, Pune India

Business Strategy- Stonebridge Associated Colleges, Cornwall, UK

Worked in India, Middle East and the UK for 20 + years

YV VY

Companies worked:

2020Imaging India Limited for Middle East Market
Wavestore Limited UK for India and Middle East Market
Mantech Computers Bahrain

Mercury Engineering for Oman and Bahrain Market
Honeywell for Oman and Bahrain Market

SECOM for Oman Market

Zicom Electronic Security System India

VVVYVYYVYVYVY

Messages - Outline of the Conference

Ubiquitous computing is a paradigm in which the processing of information is linked with each activity or
object as encountered. It involves connecting electronic devices, including embedding microprocessors to
communicate information. Devices that use ubiquitous computing have constant availability and are
completely connected.

Ubiquitous computing focus on many-to-many relationships, instead of one-to-one, many-to-one or one-
to-many in the environment, along with the idea of technology, which is constantly present. It includes
local/global, social/personal, public/private and invisible/visible features and considers knowledge
creation, as well as information dissemination




Keynote Talk Description:
- Ubiquitous computing current scenario
- Ubiquitous Affecting human life

- Ubiquitous computing future

MANOJSINGH CHOUHAN




C

ICUC - 2017

International Conference on
Ubiquitous Computing 2017

Organizing Committee

HIEF PATRONS

Prof. M. N. Navale
Founder President, Sinhgad Institutes , Pune

Dr

. (Mrs) S. M. Navale

Founder Secretary, Sinhgad Institutes ,Pune

Ms. Rachana Navale— Ashtekar

Vice-President (Admin), Sinhgad Institutes , Pune
Mr. Rohit M. Navale

Vice-President (HR), Sinhgad Institutes , Pune

PATRONS

Prof. Dr. S. M. (Raja) Dixit, Director BCUD, SPPU, Pune

Dr
Dr
Dr
Dr
Dr
Dr
Dr
Dr
Dr
Dr

G

Dr
Dr

. Y. P. Nerkar, Coordinator Faculty of Engineering, SPPU Pune
. A. V. Deshpande, Principal, SKNCOE Pune

. R. S. Prasad, Principal, NBNSSOE Pune

. S. N. Mali, Principal, SITS, Narhe

. C.B. Bangal, Principal RMDSCO, Warje

. K.P. Patil, Principal, SAE, Kondhava

. M. S. Rohakale, Principal, SKNSITS, Lonawala

. M.S. Gaikawad, Principal, SIT, Lonavala

. K. J. Karande, Principal, SKNSCO, Korti

. N.B. Navale, Principal, SCOE, Solapur

ENERAL CHAIR

. S. D. Lokhande Principal SCOE, Pune
. Y. P. Reddy Vice Principal SCOE, Pune




Convener

Prof. G.R. Pathak
Head of Information Technology Department SCOE, Pune

Co - Convener

Prof. M.P.Wankhade
Head of Computer Engineering Department SCOE, Pune

Organizing Secretary

Prof.U.A. Mande
Department of Computer Engineering SCOE, Pune

Advisory Committee

Dr. Varsha Patil, BOS Coordinator, Computer Engineering, Savitribai Phule Pune University
Dr. P.N.Mahalle, BOS Coordinator, Information Technology, Savitribai Phule Pune
University

Dr. R. B. Ingale, Professor, PICT,Pune

Dr. M. L. Dhore, Professor VIT, Pune

Dr. G. V. Garje, Head, Dept. of Computer Science, Government Polytechnic, Gondia
Dr. S. S. Sane, Professor, KKWCOE, Nashik

Dr. M.U. Kharat, Professor, MET, Nashik

Dr. P. D. Patil, Professor, Dy Patil Pimpari

Dr. U. V. Kulkarni, Professor, SGGSIE & T, Nanded

Dr. Sachin Deshmukh, Dr. BAMU University, Aurangabad

Dr. S. G. Bhirud, Professor VITI, Mumbai

Mr. Girish M. Phegade, Technical Director, Govt. of India

Dr. P.J. Kulkarni, Deputy Director, WCE, Sangli

Dr. D.B. Kulkarni, Associate Professor, WCE Sangli

Dr. R. Bhramaramba, Associate Professor, GI TAM University, Vishkhapattanam

Dr. Phani Kumar, Professor & HOD, GITAM University, Hyderabad

Dr. V.Srikanth, Professor& HOD Computer Engineering Dept. KL University, Vijaywada
Dr. V.Chandra Prakash, Professor KL University, Vijaywada

Dr. C.M. Sheelarani, Professor KL University, Vijaywada

Dr. M.S. Godwin Premi, Professor, Dept. of ETCE, Sathyabama University, Chennai
Dr. SuhasPatil, Professro, BharatiVidyapeeth Deemed University, College of Engineering,
Pune




ORGANIZING COMMITTEE

Dr. J.R.Prasad, Dept. of Computer Engineering, SCOE, Pune
Prof. C.A.Laulkar, Dept. of Computer Engineering, SCOE, Pune
Prof. G.T. Chavan, Dept. of Computer Engineering, Pune

Prof. D.D.Gatade, Dept. of Computer Engineering, SCOE, Pune
Prof. N.G.Bhojane, Dept. of Computer Engineering, SCOE, Pune
Prof. T.P.Vaidya, Dept. of Computer Engineering, SCOE, Pune
Dr. K.S. Thakare, Dept of IT, SCOE, Pune

Prof. M.V.Nimbalkar, Dept of IT, SCOE, Pune

Prof. K. S. Korabu, Dept of IT, SCOE, Pune

Prof. S.P.Potdar, Dept of IT, SCOE, Pune

Prof. Y. A. Jakhade, Dept of IT, SCOE, Pune

Prof. K. A. Hiwarekar, Dept of IT, SCOE, Pune

Dr. Rameshwar Shankarrao Kawitkar,Dept. of Electronics and Telecommunication
Engineering, SCOE, Pune




SILNO

1.

10.

11.

12.

13.

CONTENTS

TITLES AND AUTHORS

Cluster Based Data Centric Trust Management in VANET
» S.V.Saboji
» Bhagyashree K L

Synthetic Speech Spoofing Detection using MFCC and SVM
» Anagha Sonawane
» M.U.Inamdar

Sentiment Analysis Of English Tweets And Paragraph
> Milan Gaonkar

A Multi-Authority Access Control System Using Network Security
» Ms. Vibhute Shubhangi Prakash
» Mr. Kale Navnath D

Fault Tolerance Approach in Distributed Sensor Networks using Genetic Algorithm
» Anagha A.Nanoti
» R. K. Krishna

Security Privacy Preserving For Content Leaks
» Shradha V. Raghorte

Searching Comparatively Better Result From Agglomerative algorithm
» Dipalee Prakash More
» Ujawala M Patil

Dictionary Learning Arrangement for Multi-Label Image Annotation
> Yogini B. Bhadane
> Nitin N. Patil

Parallel Computing of Ordinary Differential Equations
» Pooja S. Patil
» Mukesh D Patil
» Vishwesh A. Vyawahare

Extracting The Relevant Information From The Mereged Ontology File
» Karishma Parab Gaonkar
» Umesh A. Bapat

Dummy items to hide sensitive Association rule
» Ruchi .P. Kanekar
» Rachel Dhanaraj

PAGE NO

1

10

11

High Performance FIR Filter Architecture for Fixed and Reconfigurable Applications 12

» Pallavi Rahunath Yewale
» Aparna Shinde

Implementation of SVPWM Estimation Technique for Three Phase VSI
> Priyanka. Ashok
» Reshma. Verma

13




SILNO

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

25.

CONTENTS

TITLES AND AUTHORS

Investigation of Structural Antennas for Melanoma Treatment
» Nagajyothi M
» Dr.Imaculate rosline

Improved Design of D Flip Flop for Low Power Applications
» Dr. V. Anandi
» Chethan .M.

Mitigation of Voltage Sag in Grid connected Wind System by using STATCOM
> Nilesh V. Khalkar
» Mrs. Nayana N. Jangle

Exploring Big Data Analytics for satellite imagery data using Hadoop technique
» Ch.Rajya Lakshmi
» K.RammohanRao
» R.RajeswaraRao

Coexistence of Zigbee with 802.11n
» Prerana Dhanaraj Mahajan
» Shraddha Panbude

Mqtt Based Warehouse Management System For Climacteric Fruits And Vegetables

» Priyanka Ramesh Deshmukh
» Dr.Dipashree Bhalerao

An automated brain tumour detection and severity Analysis using ANN
» Vrushali Borase
» Gayatri Naik
» Vaishali Londhe

Video Denoising using Adaptive Transform Domain Approach
» Lina Desale
> S.B.Borse

A Report on Business Intelligence The Role of Data Analysis and Data Mining in
Contemporary Organizations and The Ethical Implications of Collecting,
Storing and Using Data

» Mr. Richardson Lawrence

A Triple Band Micostrip Annular Slot-Based MIMO Antenna System
» Darshan B Kokare
> Dr Imaculate Rosaline

Implementation of File Level and Block Level Deduplication and Detecting
Attacks in Cloud Environment

» Samita Mokal

> Nilima Nikam

» Vaishali Londhe

Detection of Abnormal Human event using SUR Algorithm with HOI
» Shruti Basavaraj Kadari
» ChitraM

PAGE NO

14

15

16

17

18

20

21

22

23

24

25




SILNO

26.

27.

28.

29.

30.

31.

32.

33.

34.

35.

36.

CONTENTS

TITLES AND AUTHORS

An Intuitive Architecture for Next Generation Digital Personal Assistants
» Mehul Jain
» Utkarsh Bhatia

Meet-O-Mania (Meeting Scheduler)
» Sinchita Deb
» Pankhuri Srivastava
» Vaibhav Singh
» Shubham Mahajan

A Novel Implementation of secure VLSI logic design
» KusumaBT
» AR.Priyarenjini

Parallel Computing of Fractional Integral Operators
» Sameer S. Chikane
» Mukesh D. Patil
» Vishwesh A. Vyawahare

Different Architectures of Power Grid
» Priyanka Kanade
» Sujata Mendgudle

Parallel Computation of Mathematical Functions in Fractional Calculus
» Ms. Priya Y. Khot
» Mrs. Shweta Ashtekar
» Mr. Vishwesh A. Vyawahare
» Mr. Mukesh D Patil

Lung Cancer Detection using Log-Gabor Filter Banks
» Rupali Mali
» Dr. S.B. Bagal

Theoretical Channel allocation for SDRs in Smart Grid neighbourhood area network
» Megha Gupta

Implementation of Numerical Methods for Partial Differential Equation
Using Parallel Computing

» Mr. Akshay A Jadhav

» Mrs. Trupti Agarkar

» Mr. Vishwesh A Vyawahare

» Mr. Mukesh D Patil

Efficient Approach for Traffic Sign Detection based on Saliency Detection via
Graph-Based Manifold Ranking

» Namrata Vijay Chavan

» M.S. Borse

Reversible Data Hiding in Encrypted Video using Context Free Grammar
» Samiksha K. Velip
» Dr.J.A. Laxminarayana

PAGE NO

26

27

28

29

30

31

32

33

34

35

36




SILNO

37.

38.

39.

40.

41.

42.

43.

44,

45.

46.

47.

48.

CONTENTS

TITLES AND AUTHORS

PAGE NO

Dwt&Svd Based Watermarking Scheme For Copyright Protection In Medical Images 37

» Ms. Shubhangi D. Mashalkar
» S.S. Shirgan

EEG Signal Classification Using Feature Level Fusion
» Rohini Darade
> S.R.Baji

Implementation of Fault Tolerant Embedded Signature Analyzer
» Amol Gulab Patil
» Usha Jadhav

Comparative Non Linear Dynamic Analysis of Flat Slab Without Peripheral
Beam By Providing Infill Wall and Shear Wall Panels at Diffrent Storey Height
» Priyanka Vijaykumar Baheti
» D.S. Wadje

A Survey on interactive multilabel segmentation using cellular automata
» Monika
» Anand Prakash Shukla

Searching Comparatively Better Result From Agglomerative Algorithm
» Dipalee P. More
» Ujwala M. Patil

Patterned Fabric Defect Detection using Wavelet Golden Image Subtraction Method

» Sarojini Ganapati Naik
» M.S.Biradar
» Kishor.B.Bhangale

38

s39

40

41

42

43

Control Of three Phase Inverter in Distributed Generation using Pl and Fuzzy Controlle 44

» Shilpa A. Chaware
» Mr. S. S. Hadpe

Design of Schmitt-Trigger-Based Low Power 12T SRAM cell
» DarshanRS
» S L Gangadharaiah

Color and Texture Based Image Retrieval Based on Quadtree
» ShradhaNaik
» UmeshBapat

Development of Computer Aided Diagnosis System (CADx) for Detection  of
Anomalies in Breast using Textural Features with PNN classifier

» Miss. Ankita Satyendra Singh

» Mrs. M. M. Pawar

0T Based Secure Home Monitoring System
» Michelle S Henriques
» Nagaraj K. Vernekar

45

46

47

48




SILNO

49.

50.

Sl

52.

53.

54.

55.

56.

57.

58.

59.

60.

61.

CONTENTS

TITLES AND AUTHORS

Human Crowd Behaviour Analysis for Video Surveillance
» Shreekar Waghela
» Shreedarshan

Detection of Red Lesions For Diabetic Retinopathy In Telemedicine Context
» Kazi Syed Naseeruddin Mustafa
» SushilKumar N. Holambe

Detection of Retinal Hemorrhage in Color Fundus Image
» Priyanka kale

Improve Performance of Crawler using K-means Clustering
» Swati G. Bhoi
» Ujwala M. Patil

Simulation of Special Mathematical Functions
» Sangeeth Sadanand
» Divya K. Shah
» Vishwesh A. Vyawahare

Design of Area and Power Optimization Shift Register
» Akshata G. Shete
»  Aarti Gaikwad

Performance Analysis of a Grid Tie Voltage Source Inverter based Photovoltaic System
» G.A.Sadaphal
» S.T.Gaikwad

A Novel Approach for Image Security
» Jyoti T. G. Kankonkar
» Nitesh Naik

Hybrid technique of Image Encryption to Enhance Security
» Kalyani D. Kadukar
» R.Krishna

Health Care in Smart Cities: A Survey based on loT data analytics
» Swapnaja Rajeshb Hiray
» Dr. Brahmaramba Ravi

Malicious Misbehavior Activity Detection Using Probabilistic Threat Propagation in
Network Security
» Tejaswini S. Akulwar

Virtualization Concept and Live Virtual Machine Migration
» Divya Kapil

Efficient Design of a Reconfigurable FIR Filter using Distributed Arithmetic for
FPGA Implementation

» Reshma Ghurde

» Mrs. Aparna Shinde

PAGE NO

49

50

51

52

53

54

55

56

57

58

59

60




SILNO

62.

63.

64.

65.

66.

67.

68.

69.

70.

71.

72.

73.

74.

CONTENTS

TITLES AND AUTHORS

Conversion and Recognition of Handwritten Devanagari Character String into
Printed Character String Using K-Nearest Neighbourhood (KNN) Algorithm
» Sushma Dipakrao Pilawan
» Milind V. Bhalerao
» Dr. Abhijeet V. Nandedkar

Dynamic MCQ Generation From Ontology
» Yugandhara Yeotikar

Coexistence of Zigbee with 802.11n
» Prerana Dhanaraj Mahajan
» Shraddha Panbude

Estimation of Very Fast Transient Overvoltage’s in GIS
» Rupali. A. Ahire
> Rahul S. Patil

Iris Classification Based on K-SVD Dictionary Learning Algorithm
» Atul Pagare

Design and Analysis of Soft Error in Combinational Circuits Using NOR Gate
» Poonam S.Wankhede
» Mrs.Usha Jadhav

North Indian Raga Recognition using SVM classifier, MFCC and Pitch features
» Rajakamal S. Zanke
» Dr.D.D. Doye
» Dr.L.V.Birgale

Analysis of Similarity Measure for Text Processing
» Tulaja

Development of Computer Aided Diagnosis System (CADX) for Detection
of Anomalies in Breast using Textural Features with PNN classifier

» Ankita Satyendra Singh

» Mrs. M. M. Pawar

A Robust And Reversible Watermarking Scheme For Relational Data
» SunitaNallamadge
» R.S. Potpelwar

Online Signature Verification For Personal Authentication
» Miss. KalyaniVijaysinhGidde
» Ms.J.AKendule

Li-Fi: Audio and Data Communication using Visible Light
» Miss. P.S.Shinde
» Miss. J.A.Kendule

Pomegranate Leaf Disease Detection Using Image Processing with Support Vector

Machine Classifier
> Miss. T. N.Shaikh
> Dr.S. M. Mukane

PAGE NO

62

63

64

65

66

67

68

69

70

71

72

73

74




CONTENTS
SI.NO TITLES AND AUTHORS

75. BLE Based Automatic Attendance System
» Niranjan N. Shinde
» Ashwini A.Raorane

76. Performance Analysis of physical layer in LTE
Neha Narudkar

Tejasvini Naik

Vaishali S. Jadhav

Dr. Uttam Kolekar

YV VY

77. BLE Based Automatic Attendance System using PsoC BLE
» Niranjan N. Shinde
» Ashwini A.Raorane

PAGE NO

75

76

77




ICUC - 2017

International Conference on
Ubiquitous Computing

Pune, Maharashtra

25" _ 26" July 2017

ABSTRACTS

ICUC - 17
Organized by

Sinhgad College of Engineering, Pune
and
Institute For Engineering Research and Publication (IFERP)







International Conference on Ubiquitous Computing

Pune, Maharashtra on 25" - 26" July 2017

Cluster Based Data Centric Trust Management in
VANET

S.V.Saboj i., Department of CSE, Basaveshwar Engineering Collage Bagalkot
Bhagyash ree K.L., Department of CSE, Basaveshwar Engineering Collage Bagalkot

Abstract:--

Vehicular ad hoc networks (VANETS) require the potential to transform the way people travel
through the construction, interoperable wireless communications network that comprises cars, buses,
traffic indicators mobiles, and other devices. However, VANETS are susceptible to safety threats due to
increasing requirement on communication computing and control technologiesin this paper an challenges
has been made for create new cluster model for efficient communication among the VANET nodes this
paper emphases on data centric trust management system to provide consistent communication between
the nodes prevents the malicious nodes, RSU aided scheme help to generate the trust values. Simulation

shows the effectively analyze data provided in VANET and correctly establish trust on data

Keywords:--
VANET; RSU, cluster, Trust management;
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Synthetic Speech Spoofing Detection using MFCC and
SVM

Anagha Sonawane, Dept. of E&TC, Siddhant College of Engineering, Sudumbare Pune, India.
M.U.Inamdar, Dept. of E&TC, Siddhant College of Engineering, Sudumbare Pune, India

Abstract:--

In the recent times synthetic voice is used to deceive a speaker recognition based biometric access
systems. This paper presents synthetic speech detection in automatic speaker verification system (ASV)
for spoof detection. Canonical Mel Frequency Cepstral Coefficients (MFCC) algorithm is used for feature
extraction and Support Vector Machine (SVM) is used for classification of natural and synthetic voice.
Several experiments are carried out on ASVspoof 2015 database, showing that nonlinear SVM performs
better than linear SVM

Keywords:--
Synthetic speech detection; Spoof recognition; Automatic speaker verification; MFCC; SVM

25— 26" July 2017 ICUC -17 ISBN: 978-81-932966-2-2

Organized by:
Sinhgad College of Engineering , Pune
and
Institute For Engineering Research and Publication (IFERP)
Page | 2




International Conference on Ubiquitous Computing

Pune, Maharashtra on 25" — 26" July 2017

Sentiment Analysis Of English Tweets And Paragraph

Milan Gaonkar, Computer Engineering Department, Goa College of Engineering, India.

Abstract:--

Sentiment Analysis is an ongoing field of research in text mining field. It is also known as
opinion mining, mood extraction and emotion analysis. Nowadays, the opinions expressed through
reviews are increasing day by day on the web. It is practically impossible to analyze and extract opinions
from such huge number of reviews manually. To solve this problem an automated opinion mining
approach is needed. Extraction of mood from texts is a challenging task as it involves understanding the
underlying semantic. One aspect of research which is considered in this paper is to classify a given
tweet/paragraph whether it is of Positive[True positive ,False positive] or Negative[True negative ,False
negative] sentiment . In this paper a new approach is been proposed that uses lexicon database to assign
each word in a text a value called valence . The valence is nothing but how a single word is affecting the
whole sentence in which it is used. Every word in a sentence has its own strength and it tries to influence
the overall semantic of the sentence. Higher the value of valance of a word in the sentence, the more
influential it is. The approach proposed in this paper makes use of lexicon based approach as well as
machine based learning. It uses AFINN lexicon database to assign valance to words and Support Vector
Machine (SVM), k-Nearest Neighbors (KNN) machine learning algorithms for training and testing the
model.
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A Multi-Authority Access Control System Using Network
Security

Ms. Vibhute Shubhangi Prakash., Department of Computer Engineering, PVPIT College of Engineering, Bavdhan Pune,
Savitribai Phule Pune University, Maharashtra.

Prof. Mr. Kale Navnath D., Department of Computer Engineering, PVPIT College of Engineering, Bavdhan Pune, Savitribai

Phule Pune University, Maharashtra.

Abstract:--

Data access control is an efficient way to provide the data security in the cloud.& Attribute-based
Encryption (ABE) technique cryptographic conducting tool to guarantee data owner’s direct control on
their data in public cloud storage. In this paper, from another point of view, system lead an edge multi-
power CP-ABE access control plan for open distributed storage, named TMACS. In TMACS, exploiting
(t; n) limit mystery sharing, When system verify to the user the TTP work like a SDN. It’s having data
controller that can evaluate the each request base on ad-hoc data table, if user is authenticated system can
provide the access to specific user. Besides, by proficiently joining the customary multi-power plan with
system, system build a half and half one, which fulfils the situation of traits originating from various
powers and accomplishing security and framework level strength. The network security mechanism also
fulfil with this approach, the system has evaluate on physical network environment with 2 to 4 physical
devices and got satisfactory results than existing TMACS.

Keywords:--
Access Control, Attribute Based Encryption, Cloud computing, CP-ABE, Identity-based
encryption, multi-authority, Outsourcing, Revocation, SDN Controller, Wireless Router
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Fault Tolerance Approach in Distributed Sensor Networks
using Genetic Algorithm

Anagha A. Nanoti, Department of Computer Technology, Rajiv Gandhi College of Engineering, Research & Technology, Chandrapur
Prof. R. K. Krishna, Department of Electronics, Rajiv Gandhi College of Engineering, Research & Technology, Chandrapur

Abstract:--

Nature has always been a great source of inspiration to all kind of researches so far.Genetic
Algorithms were invented to mimic some of processes observed in natural evolution by John Holland in
1970s. GA simulates “survival of fittest” among individuals over consecutive generation for solving
optimization problems. In this paper,considering Fault tolerance as one of the important issues in
Distributed Sensor Networks (DSN).The Genetic Algorithmhasbeen proven to be the
best. TheDSNsareinterconnection of tiny, low cost,low-powered and multi-functional sensor nodes.
However these DSNs(sensors) are highly prone to malicious attacks, faults due to energy depletion and
sometimes due to link failure. When energy in some of the sensor nodes reduces or gets depleted the
implementation of Genetic Algorithm have proven to be the masterpiece for development of healthier
network than any other algorithms.As we know, prevention is better than cure.This paper aims toprevent
the sensor nodes from occurring failure. The Implementation Technique starts with population generation,
Selection with roulette wheel, then Fitness Function calculation, Crossover of fittest individuals, then
Mutation and Finally Termination of GA. Thus the Resulting next generation will have less chances of
getting faults than previous generation. Hence the main objective is to generate energy efficient DSNs and
a way towards fault tolerancets.

Keywords:--
DSNs- Distributed Sensor Networks, GA-Genetic Algorithm, Natural evolution, Energy
Depletion, Link Failure.
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“Security Privacy Preserving For Content Leaks”

Shradha V. Raghorte, m.Tech (CSE), R.CEER.T, Chandrapur, India.

Abstract:--

The information leak of sensitive data on systems has a serious threat to organization data
security. Statistics show that the improper encryption on files and communications due to human errors is
one of the leading causes of information loss. So there a need tools to identify the exposure of sensitive
data by monitoring the content in storage and transmission. However, detecting the exposure of sensitive
data information is challenging due to data transformation in the content. Transformations result in
highly unpredictable leak patterns. In this paper, it is utilize sequence alignment techniques used for
detecting complex data-leak patterns. This algorithm is designed for detecting long and inexact sensitive
data patterns. This detection is paired with a comparable sampling algorithm, which allows one to
compare the similarity of two separately sampled sequences. The system achieves good detection
accuracy in recognizing transformed leaks. It implement a parallelized version of our algorithms in
graphics processing unit to achieves high analysis data. In the case of collective privacy preservation,
organizations have to cope with some interesting conflicts. For instance, when personal information
undergoes analysis processes that produce new facts about users' shopping patterns, hobbies, or
preferences, these facts could be used in recommender systems to predict or affect their future shopping
patterns. In general, this scenario is beneficial to both users and organizations. However, when
organizations share data in a collaborative project, the goal is not only to protect personally identifiable
information but also sensitive knowledge represented by some strategic patterns..
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Searching  Comparatively  Better  Result  From
Agglomerative algorithm

Dipalee Prakash More, p. . student
Prof. Ujawala M Patil., Associates Professor

Abstract:--
In this world the Internet has become very casual for searching, the user appears to use it every

time, even they need to search keyword from any information query, search relevant word and a lot more.
Also, people use search engine like Google, Bing when they are willing to search something, wants to use
some relevant information or go to their synonyms. But searching for correct result requires more time
and less execution speed even they produce multiple choices. So, this process is very confusing for users
to decide one correct keyword amid the many results as a seek engine show overall results. For these
reasons, the present paper centering on generally showing the final result and to show exact keyword.
Intended to the agglomerative algorithmic approach is used which aim to generate exact keyword in less
time and reducing computational cost. The agglomerative approach is very useful for knowing the best
result from requiring query candidate.

Index Terms:--
Agglomerative Algorithm, Anchor-Based Pruning Solution, Baseline Solution
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Dictionary Learning Arrangement for Multi-Label Image
Annotation

Yogini B. Bhadane, PG Student, Department of Computer Engineering,SES’s R. C. Patel Institute of Technology, Shirpur, India.

Prof. Nitin N. Patil, Head &Associate Professor, Department of Computer Engineering,SES’s R. C. Patel Institute of Technology,
Shirpur, India.

Abstract:--

The passing keywords to images is of huge attention as it allows one to retrieve, directory and
recognize big collections of image data. Various systems have been designed for image annotation that
gives realistic presentation on consistent datasets. Here, studied multi-label image annotation with
dictionary learning methods. In multi-label image annotation, new (SLED) semantic label embedding
dictionary demonstration used, which is solved the problem of annotation, under softly supervised
situation. Several of the consumers have the skill to produce and store images. Peoples did not spend their
time for organizing and grouping their particular (private) image collections. So it's difficult for peoples
to finding particular (exact) images. Image annotation contains a number of methods that goals to find the
link between words and images. The multi-label image annotation system divided into two branches, i.e.
the training branch and the testing branch. In training branch, datasets are divided into exclusive groups.
In it, Fisher discrimination law used for the train the label of that image. Then co-occurrence labels would
offer the context data of that image. This context data adds into the novel dictionary table. In the testing
branch, use label propagation and reconstruction coefficient to get the score of each image label.

Key words:--
Automaticlmage Annotation,Dictionary Learning,Reconstruction Coefficient, Sparse Coding
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Parallel Computing of Ordinary Differential Equations

Pooja S. Patil, Department of Electronics, Engineering Ramrao Adik Institute of Technology
Mukesh D Patil ., Department of Electronicsand TelecommunicationEngineering, Ramrao AdikInstitute of Technology
Vishwesh A. Vyawahare., Department of ElectronicsEngineeringRamrao Adik Institute of Technology

Abstract:--

Numerical methods for solving fractional differential equations are computationally heavy due to
the floating-point operations needed, the non-local nature of the fractional differential operators and
more importantly, the data flow within the entire memory system of a computer. Hence such systems can
be implemented on Graphics Processing Unit (GPU) which has the parallel computing power for quicker
simulation. A GPU has a humber of threads where each thread can execute different program. With the
help of MATLAB and Parallel Computing toolboxes, GPU computational power can be easily accessed
from MATLAB with minimum GPU knowledge and MATLAB code can executed on the GPU. This
helps us to achieve significant faster computation than a normal CPU system. In this paper an attempt is
made to implement numerical method for simple fractional ordinary differential equation (FODE) on a
Dual Core CPU and NVIDIA GPU. This paper presents the relative performance of a GPU v/s CPU
for Fractional Euler's method to solve FODE. From the results it is observed that GPU provides speed up
for Fractional Euler's method.

Index Terms:--
fractional differential equations, fractional ordinary differential equation, Graphics Processing

Unit, MATLAB.
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Extracting The Relevant Information From The Mereged
Ontology File

Karishma Parab Gaon kar, Computer Engineering Department Goa College Of Engineering India
Prof.Umesh A. Bapat, Computer Engineering Department Goa College Of Engineering India

Abstract:--

As we know Database models, especially relational databases, enables information to be
efficiently stored and queried, but it failed in the applications that require a more ‘enriched’ meaning i.e.
Semantic information. So a successful new approach to represent semantic information has been defined
in the last decade: Ontologies. In the Semantic Web the data can be represented in the form of XML, RDF
or OWL. Ontologies are the web documents generated to provide more precise web content, thus by
improving the performance of information retrieval. This paper propose an approach to automatically
construct an ontology file from relational databases i.e. from mysqgl and from oracle. Then it performs
merging on the files which are created from relational databases. And then using SPARQL query to
extract the relevant information from the merged ontology file..

Key words:--
Semantic Web; Ontology; Relational Databases; Transformation Rules; OWL files; SPARQL

Query; Jena framework..
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Dummy items to hide sensitive Association rule

Ruchi .P. Kanekar, Computer Science and Engineering Goa College of Engineering India
Professor Rachel Dhanaraj., Computer Science and Engineering Goa College of Engineering India

Abstract:--

Association rule and data mining techniques is most commonly used now a day by every
organization and individual to extract the knowledge or the useful information from large amount of data.
Knowledge and the information gives a gain to the organization .The main objective of the association
rule hiding algorithms is to hide sensitive information so that they cannot be discovered through
association rule mining algorithm, but at the same time not losing the great benefit of association rule
mining and try to hide more and more rules and retrieve the original database without losing the integrity
of the database when association rule mining algorithm is inversed. However the proposed system will
hide the sensitive rule by using the dummy items and generate different database which is known as

modified database so that no one can get the original database

25— 26" July 2017 ICUC -17 ISBN: 978-81-932966-2-2

Organized by:
Sinhgad College of Engineering , Pune
and
Institute For Engineering Research and Publication (IFERP)

Page | 11




International Conference on Ubiquitous Computing

Pune, Maharashtra on 25" - 26" July 2017

High Performance FIR Filter Architecture for Fixed and
Reconfigurable Applications

Pallavi Rahunath Yewale, Dept. of Electronics and Telecommunication Engg. D. Y. Patil College of Engineering, Akurdi Pune,
India

Aparna Shinde., Dept. of Electronics and Telecommunication Engg. D. Y. Patil College of Engineering, Akurdi Pune, India

Abstract:--

The FIR filter with transposed structure has resister between the adders and can achieve high
throughput without adding any extra pipeline resister. Transpose form finite impulse response (FIR) filter
is a pipelined structure which supports the multiple constant multiplications (MCM) technique but direct
form FIR filter structure does not support MCM technique. The direct form FIR filter needs extra pipeline
register between the adder to reduce the delay of an adder tree and to achieve high throughput. The MCM
is more effective in Transpose form when the common operand is multiple with the set of constant
coefficients that reduce the computational delay. The implementation of MCM technique is easier in fixed
coefficient Transpose form FIR filter but complex in reconfigurable coefficients. In fixed coefficients
transpose FIR filter, area and delay are reduced by using MCM technique. The low-complexity design
using the MCM technique is implemented for fixed coefficients transpose form FIR filters and multiplier-
based design is used for reconfigurable transpose form FIR filter. The implemented transpose form FIR
filter structure achieved less area and delay than the direct-form FIR filter structure. The XILINX
software tool is used for simulation..

Keywords:--
Transpose form FIR filter, multiple constant multiplications (MCM) technique, Block processing
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Implementation of SVPWM Estimation Technique for
Three Phase VSI

Priyan ka. AShOk, Dept. of electronics and communication engineering,Ramaiah Institute of technology Bengaluru, India
Reshma. Verma., bept. of electronics and communication engineering,Ramaiah Institute of technology Bengaluru, India

Abstract:--

Space Vector Modulation (SVM) was originally developed as vector approach to Pulse Width
Modulation (PWM) for three phase inverters. It is a more sophisticated technique for generating sine
wave that provides a higher voltage to the motor with lower total harmonic distortion. The rapid
developments of power electronic device and microprocessor have led to improvement the modulation
technique to increase the power output and efficiency of the inverters. In many industrial applications the
conventional modulation technique such as Sinusoidal Pulse Width Modulation (SPWM) suffers a
problem with limited output voltage capability. This paper mainly focuses on harmonics analysis of three
phase AC supply available from three phase voltage source inverter which is fed to motor drives using
various PWM techniques. Ideally the output of inverter should be sinusoidal but due to harmonics the
output having distorted waveforms. A number of Pulse width modulation (PWM) schemes are used to
obtain variable voltage and frequency supply and there is an increasing trend of using SVPWM technique
and this proves that SVPWM is the best solution to increase the inverters output voltage and is suitable
for digital implementation. The technique for generating the PWM signal to control inverters was
implemented using VHDL and was validated using co-simulation between ModelSim and
Simulink/MATLAB. The model is implemented with a word length equal to 8 bits. The inverter is
modeled using Simulink/MATLAB. This SVPWM estimation technique by its reduced harmonic
distortion and low switching losses preserves the advantages of SVPWM and can be replaced where
computing resources are limited.
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Investigation of Structural Antennas for Melanoma
Treatment

Nagajyothi M, M.Tech (Digital electronics and communication) Department of Electronics and communication, Ramaiah Institute of
Technology,Bangalore, India

Dr.Imaculate rosline., Assistant Professor Department of Electronics and Communication Ramaiah Institute of
technology,Bangalore, India

Abstract:--

One of the applications that use nanosecond and subnanosecond high voltage pulses is cancer
therapy. In particular , non-thermal changes in the cells, especially the permeabilization of the membrane
can be introduced using subnanosecond pulses. The motivation is to radiate intense subnanosecond pulses
to the tumors non-invasively. Intense EM waves that is emitted at the first focal point is been focused at
the second focal point where the target that is the tumor is present. Two antennas with PSR are designed
to focus pulsed type field at the second focal point. The modified bicone antenna and elliptically tapered
horn antenna as feeds for PSR is designed. Comparison of design parameters and radiation performance is
done..

Keywords :--
Bicone antenna, horn antenna, melanoma treatment, prolate spheroidal reflector.
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Improved Design of D Flip Flop for Low Power
Applications

Dr. V. Anandi., Dept. of Electronics and Communication Engg, Ramaiah Institute of Technology Ramaiah Institute of Technology,
Bangalore, INDIA

Chethan .|V|., Dept. of Electronics and Communication Engg, Ramaiah Institute of Technology Ramaiah Institute of Technology,
Bangalore, INDIA

Abstract:--

An Implicit Pulse Triggered D flip flop is designed, which incorporates gated clocking. Clock
gating using XOR gate inhibits redundant internal node switching. The pull-up network (PUN) control
technique is used to conditionally strengthen the discharge path. This work aims at further reduction in
power consumption using substrate bias technique to reduce leakage power which is referred to as Back
Gate Forward/Reverse Bias method. Cadence Virtuoso 180nm technology is used to implement various
pre & post layout simulations. From the results, it can be inferred that the proposed design reduces the
power consumption by 41.82% at 10% data switching activity as compared with the existing counterparts.
A comparison of three bit counter designed using conventional transmission gate (TG) based master-slave
flip-flop and the proposed implicit pulse triggered flip flop shows a reduction of 23.90% in average power
consumption.

25— 26" July 2017 ICUC -17 ISBN: 978-81-932966-2-2

Organized by:
Sinhgad College of Engineering , Pune
and
Institute For Engineering Research and Publication (IFERP)
Page | 15




International Conference on Ubiquitous Computing

Pune, Maharashtra on 25" - 26" July 2017

Mitigation of VVoltage Sag in Grid connected Wind
System by using STATCOM

Nilesh V. Khalkar, pc student, K.K. Wagh I.E.E
Mrs. Nayana N. Jangle, Assi. Prof. K.K. Wagh LE.E. & R

Abstract:--

Now days renewable energy sources are very important for electrical power generation. In that
condition wind power generation plays an important role in power system especially under integration of
high penetration level of wind to grid, but at grid location having power quality problems like voltage sag,
voltage swell, voltage fluctuations. As we know that most of the generator are induction generator (1G),
so it requires more reactive power(VArs) from grid. In this paper according to aerodynamic aspects of
wind farms, the major power quality problem that is voltage sag is mitigated by STATCOM .Wind
turbine connected to squirrel cage induction generator(SCIG) is modeled by using MATLAB simulation
with a fault condition to mitigate voltage sag and where STATCOM inject reactive power to increase
power system stability

Keywords :--
Renewable energy, Power Quality, STATCOM, VArs, Squirrel Cage Induction Generator SCIG
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Exploring Big Data Analytics for satellite imagery data
using Hadoop technique

Ch. Rajya Lakshmi, Assistant Professor,BVRITN, Senior Scientist NRSC,Hyderabad,Professor & Head,Jntukucev
K.Rammohan Ra0., Assistant Professor,BVRITN, Senior Scientist NRSC,Hyderabad,Professor & Head,Intukucev
R.Raj eswaraRao., Assistant Professor,BVRITN, Senior Scientist NRSC,Hyderabad, Professor & Head,Jntukucev

Abstract:--

Now a days Big Data has defined very large amount of data, it includes both structured and
unstructured format. The structured data analyzing is very easy task but an unstructured data analyzing is
very difficult thatcan be produced by an individuals (eg. Twitter data)it also gathered by
sensors(eg.satellites,videos) which can range from giga bytes, tera bytes and petabytes. Big Data entitles
more and more data that can be analyzed through various analyzing technigues. If the right analytic
method is applied to unstructured datasets we can easily analyze and classifyingvarious patterns, But at
the same time will consider efficiency and scale of Data. In the real world the major issue of Big Data is
early warning predictions is the use of Satellite imagery and Radar Sensor data. In the Satellite imagery
data could reach a million derived spatial objects such data querying ,managing and various image
patterns classification is very difficult task. So a proper architecture should be proposed to gain
knowledge about Big Data for analyzing various Satellite imagery patterns classifications with
hadooptechnology. In the proposed architecture differentiate various classification methods for various
satellite imagery pattern classification methods and also proposing Google’s Map reduce C4.5 Algorithm
for effective classification to increase performance of patterns classification and increasingly large
volume of Data sets to results both time efficiency and scalabilty.This research is carrying based on
NASA Satellite data and Twitter data and also in weather forecasting.

Keywords :--
c4.5 ,Satellite imagery,Hadoop,Google’s Map Reduce.
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Coexistence of Zigbee with 802.11n

Prerana Dhan araj I\/Iahaj aNn, Dept. of Electronics and Telecommunication, Vidyalankar Institute of Technology, Wadala

Mumbai, India
Shraddha Pan bude., Dept. of Electronics, Vidyalankar Institute of Technology, Wadala Mumbai, India

Abstract:--

Wireless technologies are essential and important part of today’s world. Zigbee technology is one
of them and getting more popularity due to its advantages like low power and low-cost reliability. It is
operated on 2.4 GHz industrial scientific and medical band. On the same band, there is another standard
which is 802.11n wifi standard is also operated. When both the technologies coexist together then there is
interference occurs. As data rate of zigbee is very less compared to the wifi impact of interference is more
on zigbee technology. In this work new features of channel bonding, frame aggregation and multiple
input multiple output (MIMO) is applied to the 802.11n and effect of 802.11n on zigbee technology is
measured using different performance metrics packet delivery ratio(PDR), bit error rate (BER), control

overhead and throughput.

Keywords :--
Zigbee, 802.11n, coexistence.
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Mqtt Based Warehouse Management System For
Climacteric Fruits And Vegetables

Priyan ka Ramesh Deshmukh, Dept. of Electronics and Telecommunication Sinhgad College of Engineering, SCOE Pune,India
Prof.Dr. Dipash ree Bhalerao., Dept. of Electronics and Telecommunication Sinhgad College of Engineering, SCOE Pune, India

Abstract:--

Automation has became an inseparable part of today’s world for which IOT has emerged as an
excellent platform providing connectivity between various sensors, controllers and internet that enables
remote monitoring and controlling of different environments subject to automation. Storage is an
important aspect of the total logistic business as it directly affects the product quality and thus the entire
revenue. Considering the requirements of the perishable goods like climacteric fruits and vegetable
storing warehouses this project proposes a Warehouse Management System based on light-weight MQTT
protocol which enables the user to monitor and control the storage conditions of fruits /vegetables all the
time globally through the web page access. Further this system also provides quantitative fruits/vegetable
freshness updates and on qualitative measures it gives fruits/vegetable rotting alerts. 10T is furnished with
number of application layer protocols, thus this paper includes an overview and comparative results of
two potential M2M communication protocols, MQTT and COAP, in terms of power consumption and
network latency..

Keywords :--
I0T, MQTT, Warehouse Management System(WMS)..
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An automated brain tumour detection and severity
Analysis using ANN

Prof. Vrushali Borase,. shivajirao S. Jondhale College Of Engineering, mDombivli ,India
Prof. Gayatri Naik., Yadavrao Tasgoankar Institute of Engineering and Technology, Bhivpuri Rd, India
Prof. Vaishali Londhe., Yadavrao Tasgoankar institute of Engineering and Technology, Bhivpuri Rd, India.

Abstract:--

A Brain Cancer is very serious disease causing deaths of many individuals. The detection and
classification system must be available so that it can be diagnosed at early stages. Cancer classification
has been one of the most challenging tasks in clinical diagnosis. At present cancer classification is done
mainly by looking through the cells’ morphological differences, which do not always give a clear
distinction of cancer subtypes. Unfortunately, this may have a significant impact on the final outcome of
whether a patient could be cured effectively or not. This paper deals with such a system which uses
computer based procedures to detect tumour blocks and classify the type of tumour using Artificial
Neural Network Algorithm for MRI images of different patients. Different image processing techniques
such as image segmentation, image enhancement and feature extraction are used for detection of the brain
tumour in the MRI images of the cancer affected patients. Detecting Brain tumour using Image
Processing techniques involves four stages namely Image Pre-Processing, Image segmentation,
FeatureExtraction, and Classification. Image processing and neural network techniques are used to
improve the performance ofdetecting and classifying brain tumour in MRI images. MRI scan images are
taken for this project to process it. This work presents the artificial neural network approach.lt is used to
classify the type of tumor in MRI images. The whole systemworked in two modes firstly
Training/Learning mode and secondly Testing/Recognition mode finally gets a classified output. This
paper gives an overview of image segmentation technique based on Particle Swarm Optimization (PSO).
PSO is one of the latest and emerging digital image segmentation techniques inspired from the nature.
After segmentation features are extracted and submittedto a kernel support vector machine (KSVM)..

Keywords :--
Brain tumour detection, Artificial Neural Network, Magnetic Resonance Image.
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Video Denoising using Adaptive Transform Domain
Approach

Lina Desale., ME. student
Prof. S. B. Borse., HOD, E&TC Dept, LGNSCOE, Nashik

Abstract:--

Utmost prevailing practical digital video denoising techniques depend upon a traditional
statistical model of image noise, such as Independent and identically distributed random variables-
Gaussian noise, which is often violated in real life scenarios. For example, following foremost sources of
video noise with dissimilar statistical distributions have been identified: photon shot noise, fixed pattern
noise, amplifier noise, dark current noise and quantization noise. Performance of prevailing video
denoising algorithms will severely degrade when the algorithm is applied on those images with noises
evident from multiple sources. In this paper, a dictionary learning based scheme is proposed which
computes the basis function adaptively from the first input image frames per fifty frames. Unlike other
classical approaches like wavelet or contourlet transforms where the mother wavelet/basis functions are
constant. If the mother wavelet/basis function is constant it is more likely that it will fail to capture the
minuscule noise details from real life images. Therefore, the basis function is learnt from first frame itself.
The dictionary learning method provides sparse representation of the image. Here, hard thresholding
algorithm is applied to compute the denoised frame.

Keywords :--
video denoising, basis formation, SVD, post processing
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A Report on Business Intelligence The Role of Data
Analysis and Data Mining in  Contemporary
Organizations and The Ethical Implications of Collecting,
Storing and Using Data

Mr. Richardson Lawrence., Ballarpur Institute of Technology

Abstract:--

The purpose of this report was to understand the role of data analysis and data mining, which are
subsets of Business Intelligence, in contemporary organizations. It was also required to look at some of
the ethical problems associated with data management and suggest possible solutions or recommendations
to resolve these issues. For this study, mostly secondary data was used to analyse the concepts of Bl, the
benefits associated with it and how Bl is playing a major role in helping organizations achieve their goals
and objectives. It was found that in the current scenario, there is a huge demand for delivering real-time
information that can be used to gain a competitive edge in the market. Bl can also help in assessing the
performance management system in a company and due to the rapid increase in globalization, has spread
to all parts of the world, where information can be seamlessly delivered on any device or application that
has access to the internet. To overcome the ethical problems, it is suggested that companies provide
adequate training to the developers and end users about the implications and risks associated with the
collection, usage and storage of data. It is also suggested that companies should strive to make their
interfaces simpler as complex interfaces can lead to high training costs, loss of profits and quality issues..
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A Triple Band Micostrip Annular Slot-Based MIMO
Antenna System

Darshan B Kokare, Dept. of Electronics and Communication M.S.Ramaiah Institute of Technology Bangalore, India

Dr Imaculate Rosaline., Assistant Professor Dept. of Electronics and Communication M.S.Ramaiah Institute of Technology
Bangalore, India

Abstract:--

triple-band multiple-input-multiple-output antenna system covering the 2.45/3.6/5.2 GHz WLAN
band is presented. The antenna has four elements made up of micro-strip annular slots. Two elements
cover the lower band (2.4 and 3.6 GHz) while the other two cover the higher band (5.2 GHz). The
presented antenna is compact and occupies a volume of 60x60 x1.5 mm3. The antenna operates with 150
MHz bandwidth in the 2.4 GHz band and 200 MHz bandwidth in the higher band. The minimum
measured isolation between the antenna elements is 18 dB in all of its operating bands..

Keywords :--
MIMO antenna; triplel band; annular slot antenna; wireless LAN.
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Implementation of File Level and Block Level
Deduplication and Detecting Attacks in Cloud
Environment

Prof. Samita Mokal., Shivajirao S. Jondhale College Of Engineering, Dombivli ,India
Prof. Nilima Nikam., Yadavrao Tasgoankar Institute of Engineering and Technology, Bhivpuri Rd, India
Prof. Vaishali Londhe., Yadavrao Tasgoankar institute of Engineering and Technology, Bhivpuri Rd, India

Abstract:--

In cloud computing, security and storage space management techniques are most important
factors for improving the performance of cloud computing. Secure deduplication is a technique for
eliminating duplicate copies of storage data, and provides security to them. To reduce storage space and
upload bandwidth in cloud storage deduplication has been a well-known technique. For that purpose
convergent encryption has been extensively adopt for secure deduplication, critical issue of making
convergent encryption practical is to efficiently and reliably manage a huge number of convergent keys.
The basic idea in this paper is that we can eliminate duplicate copies of storage data and limit the damage
of stolen data if we decrease the value of that stolen information to the attacker. This paper makes the first
attempt to formally address the problem of achieving efficient and reliable key management in secure
deduplication. We first introduce a baseline approach in which each user holds an independent master key
for encrypting the convergent keys and outsourcing them. However, such a baseline key management
scheme generates an enormous number of keys with the increasing number of users and requires users to
dedicatedly protect the master keys. To this end, we propose Dekey, User Behavior Profiling and Decoys
technology. Dekey new construction in which users do not need to manage any keys on their own but
instead securely distribute the convergent key shares across multiple servers for insider attacker. As a
proof of concept, we implement Dekey using the Ramp secret sharing scheme and demonstrate that
Dekey incurs limited overhead in realistic environments. User profiling and decoys, then, serve two
purposes. First one is validating whether data access is authorized when abnormal information access is
detected, and second one is that confusing the attacker with bogus information. We posit that the
combination of these security features will provide unprecedented levels of security for the deduplication
in insider and outsider attacker.

Keywords :--
Deduplication , proof of ownership, convergent encryption, key management, decoy technology.
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Detection of Abnormal Human event using SUR
Algorithm with HOI

Shruti Basavaraj Kadari, M.Tech (Digital Electronics and Communication) Department of Electronics and Communication
Engg. Ramaiah Institute of Technology, Bengaluru, India

Chitra M., Assistant Professor, Department of Electronics and Communication Engg. Ramaiah Institute of Technology Bengaluru, India

Abstract:--

Detection of complex human occasions in recordings and pictures is a testing issue of PC vision.
The difficulty lies in developing compelling association between human exercises and particular
occasions. In this paper we concentrate on unsafe human activity, particularly when individuals with
handheld weapons before they utilize it. By presenting Human-Question-Interaction model, we can set up
techniques and frameworks to perceive occasions that are dangerous. In this paper, the procedure of
occasion comprehension depends on recognizing dangerous human events predicted by the human body
parts. Using a developed dangerous human event date set, we demonstrate our model and framework beat
ordinary occasion order approaches in efficiency

Keywords :--
Dangerous object classification, Human event classification, Human-object-Intereaction, SURF

Algorithum.

25— 26" July 2017 ICUC -17 ISBN: 978-81-932966-2-2

Organized by:
Sinhgad College of Engineering , Pune
and
Institute For Engineering Research and Publication (IFERP)
Page | 25




International Conference on Ubiquitous Computing

Pune, Maharashtra on 25" - 26" July 2017

An Intuitive Architecture for Next Generation Digital
Personal Assistants

Mehul Jain, Indian Institute of Technology (Indian School of Mines), Dhanbad
Utkarsh Bhatia, indian Institute of Technology (Indian School of Mines), Dhanbad

Abstract:--

Current voice-based digital assistants despite their claims of being intelligent, lack abilities that a
true personal assistant must possess like extendable skill set, dynamic adaptation and high context
awareness. In this paper, we highlight some design and implementation requirements that must be met in
order for the development of next generation digital personal assistants and propose a general
architectural backbone that can be used to make headway for such personalized speech-operated assistive
technology. In particular, we confer about issues of extensibility of the skill set used by the digital
assistant, hypothesis generation and evaluation, extensive user adaptation, and redundant representations
handling in the design. Further, we briefly discuss the research and development directions that are
undertaken to tackle challenges put by such a system. We then consider a scenario and illustrate the data
flow in our architecture.

25— 26" July 2017 ICUC -17 ISBN: 978-81-932966-2-2

Organized by:
Sinhgad College of Engineering , Pune
and
Institute For Engineering Research and Publication (IFERP)
Page | 26




International Conference on Ubiquitous Computing

Pune, Maharashtra on 25" — 26" July 2017

Meet-O-Mania (Meeting Scheduler)

Sinchita DEb, Department of Information Technology, Bharati Vidyapeeth Deemed University College of Engineering Pune-Satara
Road, Pune — 411043, Maharashtra, India

Pankhuri Srivastava, Department of Information Technology, Bharati Vidyapeeth Deemed University College of Engineering
Pune-Satara Road, Pune — 411043, Maharashtra, India

Vaibhav Singh, Department of Information Technology, Bharati Vidyapeeth Deemed University College of Engineering Pune-Satara
Road, Pune — 411043, Maharashtra, India

Shubham Mahajan., Department of Information Technology, Bharati Vidyapeeth Deemed University College of Engineering Pune-
Satara Road, Pune — 411043, Maharashtra, India

Abstract:--

In today’s fast moving world, scheduling meetings and making it a point to have everybody
present for it has become a major workload. Majority of working professional in small enterprises,
hospitals, schools or in metro cities don’t get enough time to schedule for a particular cause in a given
time, let alone make sure every required person gets the message to attend the meetings. With Meet-O-
Mania, this task just becomes a lot easier. Meet-O-Mania is an online application used on web server that
will help in scheduling meetings on a departmental level. To use this, the user has to register into the
application with their names, credentials and email ids. Then, the admin logs into the application with his
email id , user name and password. The scheduler approaches the admin, or the admin himself schedules
the required meeting with a specific agenda. The venue and the date is mentioned along with the person
initiating the meeting. The scheduled meeting should not overlap with any other meeting. After the
meeting is held, an audio tape of the same is recorded and uploaded, along with all the outcomes of the
meeting. Any user can refer to them in future for assistance.

Index Term:--
Meeting Scheduler and Planner (MSAP)
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A Novel Implementation of secure VLSI logic design

Kusuma B T., student, ECE, MSRIT
A.R.Priyarenjini ., Asst. Professor, ECE, MSRIT

Abstract:--

Crypto circuits can be attacked by third parties using differential power analysis (DPA), which
uses power consumption dependence on data being processed to reveal critical information. To protect
security devices against this issue, differential logic styles with (almost) constant power dissipation are
widely used. However, to use such circuits effectively for secure applications it is necessary to eliminate
any energy-secure flaw in security in the shape of memory effects that could leak information. This paper
proposes a design methodology to improve pull-down logic configuration for secure differential gates by
redistributing the charge stored in internal nodes and thus, removing memory effects that represent a
significant threat to security. To evaluate the methodology, it was applied to the design of AND/NAND
and XOR/XNOR gates in a 90 nm technology, adopting the Sense amplifier based logic (SABL) style for
the pull-up network. Shox 8 can be implemented using these circuits for the security purpose..

Keywords:--

Complementary metal oxide semiconductor (CMOS) digital circuits, differential power analysis
(DPA), side-channel attacks(SCA), and very large scale integration (VLSI) design of cryptographic
circuits.
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Parallel Computing of Fractional Integral Operators

Sameer S. Chikane., Department of Electronics Engineering, Ramrao Adik Institute of Technology
Mukesh D. Patil ., Department of Electronics and Telecommunication Engineering, Ramrao Adik Institute of Technology
Vishwesh A. Vyawahare., Department of Electronics Engineering, Ramrao Adik Institute of Technology

Abstract:--

Fractional calculus is a field of mathematical analysis and applicable in various domains such as
image processing, financial system design, power transmission units, automobiles and various control
system. Fractional calculus has many advantages in analytical world. However, the computational cost
associated to it has prevented software implementations to achieve real-time performance for large and
complex computations. This paper demonstrates the parallel computing power of the Graphics Processing
Unit (GPU) in the area of fractional-order derivatives and integrations. Numerical methods for
implementing different fractional-order derivatives and integrations are available. With the help of
MATLAB Parallel Computing Toolbox, GPU computational power can be easily accessed with minimum
knowledge of GPU architecture and MATLAB code can executed on the GPU. The fractional-order
integration by Trapezoidal formula using NVIDIA GPU with support of MATLAB Parallel Computing
Toolbox is implemented in order to achieve faster execution. Performance comparison of our algorithm
for sequential implementation on CPU and parallel implementation on GPU is carried out. This new
algorithm produces significant speedup in the computations of these fractional-order derivative and
integrations and provide required result in much less time compared to execution on CPU..

Keywords:--
fractional calculus, fractional derivatives, fractional integrals, Graphics Processing Unit,
MATLAB..
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Different Architectures of Power Grid

Priyan ka Kanade., Electronics Deparment of Ramrao Adik Institute of Technology, Nerul
SUj ata Mendg udle., Electronics Deparment of Ramrao Adik Institute of Technology, Nerul

Abstract:--

There are many challenges that electrical grid face today such as mission critical power demands,
diversion of energy sources and integration of renewable energy sources. Also, the different domains have
their own requirements. To beat these challenges, it required the intelligent management of the electrical
grid. So in this survey we represents the four different types of architecture which is suitable for the

different domains.

Index Terms:--
Power grid, Cyber Structure, Micro Grid, loT, Network Topology..
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Parallel Computation of Mathematical Functions in
Fractional Calculus

Ms. Priya Y. KhOt, Department of Electronics Engineering Ramrao Adik Institute of Technology

Mrs. Shweta Ashte kar, Department of Electronics Engineering Ramrao Adik Institute of Technology

Mr. Vishwesh A. Vyawahare., Department of Electronics Engineering Ramrao Adik Institute of Technology

Mr. Mukesh D Patil ., Department of Electronics and Telecommunication Engineering Ramrao Adik Institute of Technology

Abstract:--

Fractional calculus is all about a generalization of ordinary differentiation and integration to
arbitrary (non-integer) order. Special Functions of Fractional Calculus (SFs of FC) enjoys increasing
interest from both theoretical mathematicians and applied scientists. This is due to their role as solutions
of fractional order differential and integral equations, as the better mathematical models of phenomena of
various physical, engineering, automatization, chemical, biological, Earth science, economics etc. nature.
Principle objective of this work is to implement Special Functions of Fractional calculus with the help of
Graphics Processing Unit (GPU) using MATLAB. GPU Computing makes use of CPU along with GPU
for faster computation. This computation speed is achieved by offloading parallel portions of numerical
algorithm to GPU, while simultaneously serial portions to be executed on CPU. Error Function,
Complementary Error Function and Weber function are implemented on MATLAB and execution speed
for both CPU computing and GPU computing are compared for faster computation. From the results it is
observed that around 30X speedup is achieved in the computation of special functions using GPU

Keywords:--
Fractional calculus, Graphics Processing Unit, Special Functions, Parallel Computing Toolbox.
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Lung Cancer Detection using Log-Gabor Filter Banks

Rupali Mali., M.E. Student

Dr. S. B. Bagal ., Principal, LGNSCOE, Nashik

Abstract:--

Lung cancer is the foremostreason of deaths due to cancer diseasearound the world. As per the
report of theWorld Health Organization (WHO) near about 10 million patients in the worldwill be
deceasedbecause of lung cancer by 2030. Timelyinhibition of lung tumorplays an imperative role for
survival assistanceenhancements. By following the notion that heavyinvestigation of radiographic
imageries canapprise and enumerate the microenvironment and the degree oftumor level heterogeneity for
personalized medicine,examination of huge numbers of image features extracted fromcomputed
tomography (CT). The focus is on high throughput that can apprehendspatial and temporal genetic
heterogeneity in a without operating the patient, which preferred overintrinsic biopsy based
molecularassays method.The lung cancer detection is valuable for ongoing medical research and
computer-assisteddiagnosis of lung cancer. In this paper, we have presented lung cancer detection
algorithm that yields possible location of tumor in the lung. The algorithmic steps comprises of histogram
equalization of the CT scan image followed by log- Gabor filter bank processing to enhance the CT scan
image. Subsequently the image is dilated using gradient mask and after border clearing, the location of
possible tumor is detected. This algorithm gives accurate results on publically shared CT scan images

Keywords:--
Log- Gabor filter bank, lung cancer detection, CT scan images, Dilation, histogram processing
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Theoretical Channel allocation for SDRs in Smart Grid
neighbourhood area network

Megha Gupta, IT dept, JIMS Rohini, Delhi.

Abstract:--

Smart Grid (SG) is an intelligent power supply system. It is a new emerging concept to increase
the features of local grids. Till now local grids were only providing electricity; but now they will also
take part in information exchange. Data as well as power communication can take place between a Smart
Home (SH) and Smart Grid (SG). Real time data can be sent from SH to SG through neighborhood area
network (NAN). There can be different wireless medium for transmission in NAN. Our wireless medium
is based on Cognitive Radio (CR) technology which is also called as Intelligent Software Defined Radios
(SDRs) network. Cognitive radio network works in unused spectrum that is the frequency available at the
time of need. In this paper, we are presenting a theoretical channel selection method for SG neighborhood
area network. Our work is novel in terms of single hop communication and SDRs, which have not been
explored much. In SG, research focus is on wireless sensors network and multihop communication. But
we are supporting direct communication between smart home and smart grid; that would increase delivery
ratio and throughput and also decrease end to end latency. In future, we will be providing simulation of
this model and enhancing it for secure communication.

Keywords:--

cognitive radio network; software defined radios; smart grid; channel allocation; routing protocol;
NAN
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Implementation of Numerical Methods for Partial
Differential Equation Using Parallel Computing

Mr. Akshay A Jad hav, Department of Electronics Engineering Ramrao Adik Institute of Technology.

Mrs. Trupti Agarkar, Department of Electronics Engineering Ramrao Adik Institute of Technology..

Mr. Vishwesh A Vyawahare, Department of Electronics Engineering Ramrao Adik Institute of Technology.
Mr. Mukesh D Pati |, Department of Electronics Engineering Ramrao Adik Institute of Technology.

Abstract:--

The performance and use of parallel computing in the field of differential calculus is increased
tremendously opening up new avenues for applying these in the field of numerical computation for high
speed performance. The computation time required to find analytical as well as numerical solution is
tested and compared. In this work we have harnessed this property of GPU to accelerate the grid point
calculations for numerical calculations and the performance of numerical method using CPU and GPU is
compared. The numerical Methods for integer order PDE are studied, analyzed and implemented on GPU
using parallel computing toolbox of MATLAB. The finite difference methods of PDE like explicit,
implicit method are tested for the results, for parabolic, hyperbolic and elliptical type of PDE’s. The
positive speed up is achieved for elliptical type of PDE. The verification of results with the analytical
solution is made by the mean square error..

Keywords:--
Parallel Computing Toolbox, GPU Computing, Partial Differential Equation, Numerical Method.
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Efficient Approach for Traffic Sign Detection based on
Saliency Detection via Graph-Based Manifold Ranking

Miss.Namrata Vlj ay Chavan., PG Student, Department of Electronics & Telecommunication Engineering, Late G. N. Sapkal
College of Engineering, Nashik, Maharashtra, India

Prof.M.S. Bo I'SE., Professor, Department of Electronics & Telecommunication Engineering, Late G. N. Sapkal College of Engineering,
Nashik, Maharashtra, India

Abstract:--

Now days, traffic sign detection attracted large number of researchers interest due to its important
in efficient intelligent transportation systems (ITSs). Traffic sign detection helps to minimize the road
accidents and hence to minimize the loss. The efficient traffic sign detection is vital research problem
since from last decade. In ITSs, there is more work conducted already on name plate detection and
recognition, however there only few concrete research studies presented to solve the problem of traffic
sign detection and recognition. For applications like road surveying, autonomous vehicles are mainly
demanding the system of road side sign detection and recognition. The current methods for road side sign
detection having issues of efficiency and accuracy due to different factors affecting on road sign detection
such as shadow, non-uniform sizes of signs, illumination conditions, blurring, occlusion, and sign
deterioration etc. In this work, we proposed novel method for road sign detection and recognition based
on saliency regions detection. Saliency regions detection helps to locate the road sign efficiently and
hence traffic sign detection properly. In this paper, author introduced the efficient segmentation method
and graph based ranking approach for the accurate detection salient regions. Additionally we applied the
RGB image smoothing algorithm to improve the detection accuracy. The performance results claims that
proposed approach outperforming the previous method.

Index Terms:--
Saliency Detection, Traffic Sign Detection, Segmentation, Salient regions, Manifold ranking
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Reversible Data Hiding in Encrypted Video using Context
Free Grammar

Samiksha K. Velip, Computer Science and Engineering, Goa college of Engineering, Farmagudi ,Goa ,India
Dr.J.A. Laxminarayana, Computer Science and Engineering, Goa college of Engineering, Farmagudi ,Goa ,India.

Abstract:--

In recent years the topic of steganography has become very popular and a lot of research is being
done in this field. The use of computer networks for data transmission has created the need for security.
The security plays an important role in transmission of confidential data over internet. So, as a part of
improving security in data transmission, we will hide the data inside an encrypted video. Thereby,
confidentiality of the video as well as theembedded data is maintained. The embedded data can be
extracted without any error, and also the cover video restoration is also free from error. In this paper, we
embed the data in form of context free grammar in an image by using LSB matching technique, so that
fast, optimal and lossless steganography is achieved. The proposed method provides total data security
and total sreversibility, that is, data extraction and video recovery.
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Dwt&Svd Based Watermarking Scheme For Copyright

Protection In Medical Images.

Ms. Shubhangi D. Mashalkar, P. G. Student,N.B. NavaleSinhgad College Of Engineering Solapur, India
Prof. S. S. Shirgan, Head of Department, N.B. NavaleSinhgad College Of Engineering Solapur, India.

Abstract:--

Watermarking is a popular method for copyright protection. This technique seems to be very
popular and helpful for protecting the privacy of patients by doing watermarking procedure on medical
images. In this watermarking scheme a text image is created which may vary from patient to patient and
is embedded on the MRI images to generate a secure image which contain hidden patient data (not visible
to naked eyes). Two methods are implemented for watermarking i.e. Discrete Wavelet Transform and
Singular Value Decomposition. The PSNR (between original MRI image and generated secure image)
and correlation (between patient text information and extracted watermark image) are calculated to check

the robustness and capacity of the scheme..

25— 26" July 2017 ICUC -17 ISBN: 978-81-932966-2-2

Organized by:
Sinhgad College of Engineering , Pune
and
Institute For Engineering Research and Publication (IFERP)

Page | 37




International Conference on Ubiquitous Computing

Pune, Maharashtra on 25" - 26" July 2017

EEG Signal Classification Using Feature Level Fusion

Rohini Darade., ME. student
Prof. S. R. Baji., Assistant Professor, E&TC Dept, LGNSCOE, Nashik

Abstract:--

Human brain is a diverse creature, and unveils rich spatiotemporal dynamics. Among the
noninvasive techniques for probing human brain dynamics, electroencephalography (EEG) provides a
direct measure of cortical activity with millisecond temporal resolution. Electroencephalogram is a signal
produced in the human brain when there is an information flow among several neurons. Human brain
contains millions of neurons which are responsible for information flow. We have classified the
publically available dataset for testing between normal and epileptic persons. We have achieved accuracy

of 99.88% which is highest accuracy on this dataset.

Index Terms:--
EEG, SVM, Classifier, post processing.
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Implementation of Fault Tolerant Embedded Signature

Analyzer

Amol Gulab Patil, Dept. of Electronics and Telecommunication Engg. D. Y. Patil College of Engineering, AkurdiPune, India.

Usha Jadhav, Dept. of Electronics and Telecommunication Engg. D. Y. Patil College of Engineering, Akurdi Pune, India

Abstract:--

To test and verify arithmetic and logic operations performed by digital circuits an arithmetic and
algebraic codes are used. Residue generator is an important unit of hardware implementation of arithmetic
code which generates residue of number with respect to check base. The proposed system uses residue
generator with arbitrary check base. It is shown that to reduce the probability of error escape, when
proposed residue generator is used for detecting arithmetic errors. The proposed generator is embed into a
microprogrammable finite state machine to test its operation without adding hardware overhead. The
proposed method can be used in arithmetic/algebraic error-control and fault-tolerant digital designs.

Keywords:—

Built-in self-test, cyclic redundancy check codes, design for testability, digital circuits, error

correction codes, fault detection, fault tolerant system.
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Comparative Non Linear Dynamic Analysis of Flat Slab
Without Peripheral Beam By Providing Infill Wall and
Shear Wall Panels at Diffrent Storey Height

Priyan ka Vlj ayku mar Baheti, P.G. student of Structural Engineering, Deogiri Institute of Engineering & Management studies
Prof. D.S. Wadje, Assistant Professor of Civil Engineering Department, Deogiri Institute of Engineering & Management studies

Abstract:--

In this paper assessed the comparative non-linear dynamic analysis of flat slab without peripheral
beam by providing infill wall and shear wall panel at diffrent storey height of structure such as G+4, G+8
and G+12 storey. The flab slab structure for non linear dynamic analysis i.e. time history analysis
considered two earthqaukes records such as Kobe in Japan and Koyna in India. Therefore the parametric
study on mathematical model of Flat slab create in E-TABS software. The analysis with regards
displacement, base shear, velocity at the top floor of beam for non linear dynamic analysis by using four
time history analysis..

Keywords:—
Flat slab without peripheral beam, Time history analysis, Infill wall and shear wall panel , time
history analysis, finite element software E-TABS.
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A Survey on interactive multilabel segmentation using

cellular automata

Monika, KIET Group of Institutions, Ghaziabad, India
Anand Prakash Shukla, KIET Group of Institutions, Ghaziabad, India

Abstract:--

Image segmentation is the process of partitioning a digital image into multiple segments. The
goal of segmentation is to change the representation of an image into more meaningful and easier to
analyze format. There are various interactive approaches to segment the area of interest from the given
image. In this paper a survey on various image segmentation techniques has been performed and the
methods are classified and compared as per the techniques used. The results of the segmentations are also
compared both quantitatively and qualitatively. This survey provide a base for the future research in field

of image segmentation.
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Searching  Comparatively  Better  Result  From
Agglomerative Algorithm

Dipalee P. More, M.E. scholar,
Prof. ijala M. Patil, Associate Professor

Abstract:--

In this world the Internet has become very casual for searching, the user appears to use it every
time, even they need to search keyword from any information query, search relevant word and a lot more.
Also, people use search engine like Google, Bing when they are willing to search something, wants to use
some relevant information or go to their synonyms. But searching for correct result requires more time
and less execution speed even they produce multiple choices. So, this process is very confusing for users
to decide one correct keyword amid the many results as a seek engine show overall results. For these
reasons, the present paper centering on generally showing the final result and too show exact keyword.
Intended to the agglomerative algorithmic approach is used which aim to generate exact keyword in less
time and reducing computational cost. The agglomerative approach is very useful for knowing the best
result from requiring query candidate.

Keywords:—
Agglomerative Algorithm, Baseline Solution, Anchor-Based Pruning Solution.
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Patterned Fabric Defect Detection using Wavelet Golden
Image Subtraction Method

Sarojini Ganapati Naik, E & TC Dept. Siddhant College of Engg , Sudumbare, Pune — 412109
M.S.Bi radar, E & TC Dept. Siddhant College of Engg , Sudumbare, Pune — 412109
Kishor.B.Bhangale, £ & T Dept. Dr.D.Y Patil College of Engg, Akurdi, Pune-411044

Abstract:--

In this paper decomposition of fabric, the image is done using wavelet transform method. The
wavelet decomposition for the defective image as well as for original image is done. The wavelet
decomposed defective image vertical component is subtracted from the non defective image. Finally
thresholding and filtering techniques used to get defect.

Keywords:—
Morphological filter, Thresholding, Wavelet decomposition, Wavelet Filter
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Control Of three Phase Inverter in Distributed Generation

using Pl and Fuzzy Controller

Shllpa A. Chaware, PG student, Matoshri CoE &Research
Mr. S. S. Had P€, Assi. Prof., Matoshri CoE &Research

Abstract:--

This paper presents the effective control strategy for the control of three phase PWM inverter
connected to the distributed generation. This inverter is used to convert the DG output to the alternating
guantity as required by the load and also to interface the DG unit to the grid. The proposed scheme uses a
single controller to control the inverter in both the islanded and grid connected mode of operation. In the
propose scheme the output power of the inverter is controlled in the transition stages of the given system.
For that it uses the synchronous reference frame for controlling the inverter. Also the advantage of
proposed strategy is that it does not require any islanding detection scheme. Finally the effectiveness of

the proposes control scheme is validated in MATLAB simulation..

Index Terms:—
Distributed Generation, Fuzzy controller, PI controller, PLL,SRF ..
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Design of Schmitt-Trigger-Based Low Power 12T SRAM
cell

Darshan R S., M.Tech student

S L Gangadharaiah. y Assistant Professor

Abstract:--

As the technology is being scaled down leakage power is becoming an important contributing
factor in total power dissipation of the circuit. So in the portable electronic devices such as cell phones,
laptops emphasis has to be given to reduce power consumption during active as well as standby mode.
This paper presents a Schmitt-trigger-based 12T SRAM cell which consumes lowest average power as
well as lowest leakage power among the cells considered for comparison. The results have been obtained
using Cadence Virtuoso Tool with 180nm Technology. The layout is drawn in 180nm technology to
verify Design rule check and layout versus simulation for the proposed 12T SRAM cell
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Color and Texture Based Image Retrieval Based on
Quadtree

ShradhaNai k, Computer Engineering Department, Goa College Of Engineering,Farmagudi, PondaGoa, India
Prof. Umesh Bapat, Associate Professor Computer Engineering Department, Goa College Of Engineering,Farmagudi, PondaGoa, India

Abstract:--

With the increasing demand for need of retrieval of images based on different aspects, properties,
characteristics there has been tremendous research going on in the field of Content-based image retrieval
(CBIR), also known as query by image content (QBIC). Content here is referred to visual features ie
colour, texture,shape, spatial layout of an image which needs to be extracted.Basically CBIR comprises of
3 main steps, first is feature extraction of database and query images, second is feature matching using
similarity criteria and lastly third step is retrieval based on highest matching quotient. This paper proposes
a novel approach wherein content based image retrieval is based on color and texture primarily
implementing color histogram for color based and gabor filter for texture based retrieval. Colour
histogram comprises of two colour models(RGB and HSV).Retrieval is also based on extracting
individually RGB and HSV colour components in order to make a comparative analysis on different types
of retrieval.For texture based,Frequency and orientation representations of Gabor filters are similar to
those of the human visual system, and they have been found to be particularly appropriate for texture
representation and discrimination.Main aim of this paper is to implement a new technique that is quadtree
segmentation on query and database images and then apply feature extraction iecolor histogram on all
images and match the query and database images using similarity criteria.Similarity metric used in this
paper is Euclidean distance. Quad tree is a segmentation technique which divides image into
homogeneous blocks.Hence the name Quadhistogramis a new revised technique to implement colour
based retrieval under local colour histogram which divides the images into homogeneous blocks and then
compute histogram of each block.

Keywords:—
CBIR, colour histogram(RGB, HSV), gabor filter , quadtree, quadhistogram
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Development of Computer Aided Diagnosis System
(CADx) for Detection  of Anomalies in Breast using
Textural Features with PNN classifier

Miss. Ankita Satyend ra Singh, Department of Electronics and Telecommunication Engineering SVERI’s COE Pandharpur,
Solapur Mabharashtra, India

Prof. Mrs. M. M. Pawalr, Department of Electronics and Telecommunication Engineering SVERI’s COE Pandharpur, Solapur
Maharashtra, India

Abstract:--

High False Negative Rate (FNR) is a very significant problem in a Computer Aided Diagnostic
System as false negative answer may lead to a very high increase in the number of deaths. The main aim
of this paper lies in the development of a new Computer Aided Diagnosis (CADX) system for the proper
identification of breast masses. It also focuses at extraction of textural features. The input images are pre-
processed by using Adaptive Median Filter and then segmented by using Gaussian Mixture Model i.e.
GMM segmentation and further are subjected to feature extraction, selection and finally classification by
using PNN classifier. MIAS database is used for research purpose which contains 322 mammogram
images out of which 60 images as 20 of benign, 20 malignant and 20 normal are taken into consideration
for feature extraction. 22 texture features are extracted and are further classified. PNN classifier with 80-
20 train-test partition is used for classification. The Sensitivity, Specificity and Accuracy obtained by the
selected features are 100%, 100%, and 100% respectively

Keywords:--
Mammaogram, Pre-processing, Adaptive Median Filter ,Gaussian Mixture Model (GMM), EM
algorithm, MAP algorithm, Image segmentation, Texture features, Classification, PNN classifier.
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loT Based Secure Home Monitoring System

Michelle S Hen riques., Computer Engineering Department, Goa College of Engineering
Prof. Nagaraj K. Vernekar., Computer Engineering Department, Goa College of Engineering

Abstract:--

Internet of Things (loT) allows computing and sensing devices, generally embedded in everyday
objects, to be interconnected via the Internet, allowing them to send and receive data. 10T allows objects
such as sensors, appliances to be sensed and controlled remotely across a network. Home monitoring is
one of the fastest growing fields of the loT technology. It comprises of a network of devices/sensors
which handle applications such as home automation (lighting control, device control,etc.), monitoring
(climate, gas,etc.) and security. As the information is highly critical, a home monitoring system has high
security requirements. The security requirements are not limited to user authentication, but also to
encrypted communication among devices as well as device authentication. The proposed idea in this
paper is to add a layer of security to the concept of Home Monitoring, both at the user level and the
device level. The communication between the sensors(devices) and the Home server will be encrypted
using a combination of Symmetric and Asymmetric cryptography. Symmetric cryptography is used for
encryption of the sensor data using a random key and Asymmetric cryptography is used to encrypt the
random key. A maodified version of the Vigenere cipher is used for encryption of sensor data. The key
used for encryption is generated at random using the timestamp. The random key is encrypted using RSA
(Asymmetric cryptography) using the home server’s public key. This ensures that only the home server
will be able to decrypt the key using its private key. At the user end, two-phase authentication will be
used for user login. Any intrusions would be detected using honeywords (false passwords). With the
above proposed idea(s), the communication within system will be encrypted and would be tolerant to
attacks. On the user end, only authenticated users will be able to access and control the system. The use of
Honeywords will make password cracking very difficult as well as it will enable detection of any
intrusions.

Index Terms:--
Cryptography, Encryption, Internet of Things (1oT), Security, Vigenere.
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Human Crowd Behaviour Analysis for Video
Surveillance

Shreekar Waghela., Ramaiah Institute of Technology, Bangalore, India
Shreedarshan., Ramaiah Institute of Technology, Bangalore, India

Abstract:--
Video surveillance is very essential as threat and crime increases. Camera based surveillance

systems are installed in most of the places like office buildings, stadiums, traffic signals and many other
crowded places. These security cameras require incessant human presence for monitoring the footage and
if any anomaly is detected they inform the officials by issuing an alert. Since it is all done manually, it is
essential they should be concentrated all the time. So it is possible that a lack in concentration may result
in an incident gone unnoticed. To overcome this problem a system needs to be developed which can
detect behaviour and then identify it as normal or abnormal. Most of the behaviour detecting methods
available today, work on tracking individuals. This results in increased computational cost. In this project,
a method is proposed in which the behaviour of crowd is detected without individual tracking of objects
in a frame. This method is based on the motion intensity of the crowd which can be determined by
accumulating all optical flow vectors of a frame. The abnormal crowd activity can then be detected by
setting up a threshold to detect any sudden change in motion intensity

Index Terms:--
Anomaly Detection, DynamicThreshold, Motion Intensity, Optical Flow
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Detection of Red Lesions For Diabetic Retinopathy
In Telemedicine Context

Kazi Syed Naseeruddin Mustafa., PG scholar Department of M.E.(C.S.E.), T.P.C.T.’s College Of Engineering, Osmanabad,
India.

Prof.SushilKumar N. Holambe., professor Department of C.S.E.,T.P.C.T.’s College Of Engineering, Osmanabad, India

Abstract:--
In this paper we present the Red Lesion Detection for diabetic retinopathy in telemedicine

context. The method used in this in this paper is the process of morphological image flooding. The
development of an automatic telemedicine system for computer-aided screening and grading of diabetic
retinopathy depends on reliable detection of retinal lesions in fundus images Signs of DR include red
lesions such as microaneurysms and intraretinal hemorrhages, and white lesions, such as exudates and
cottonwool spots. This paper concerns only the red lesions, which are among the first unequivocal signs
of DR. Therefore, their detection is critical for a prescreening system.

Keywords:--
Diabetic retinopathy,fundus IMAGING, lesion detection, retina, screening.
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Detection of Retinal Hemorrhage in Color Fundus
Image

Priyan ka kale, Department of Computer Technology, Rajiv Gandhi College of Engineering, Research & Technology

Abstract:--
Diabetes is the major reason for visual loss. Diabetic retinopathy occurs on the retinal part of the

eye. In earlier days, human experts manually identify the symptoms of diabetic retinopathy in the digital
color fundus images of retina taken with the help of ophthalmoscope or fundus photography. It requires
highly trained and skilled experts to perform diagnosis. But due to the increasing number of people with
diabetes, detection of DR symptoms is found to be a heavy and inaccurate task while screening a large
number of images. Hemorrhages are the first symptoms that indicate diabetic retinopathy. Therefore, their
detection is very important. This paper aims to concentrate on detection of blood vessels and
haemorrhages as the boundaries of hemorrhages are not preserved when they are in contact with blood
vessels. We will skip bold vessels as we are interested in only haemorrhages. An image obtained from
internet contains noise so need to enhance contrast by pre-processing and blood vessels will detect. Then
classification will be done on the basis texture feature such as area, size and standard deviation etc. finally
we will classify the images into normal, moderate and Severe DR.thus the objective of the current work is
to identify hemorrhages as the early detection of DR through screening can prevent blindness and allow
for maintenance of good vision.

Keywords:--
Blood vessel, Diabetic retinopathy, DR, Haemorrhages.
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Improve Performance of Crawler using K-means
Clustering

Swati G. BhOi, M.E. Scholar, Department of Computer Engineering ,SES’s R. C. Patel Institute of Technology, Shirpur, India
ijala M. Patil., Associate Professor, Department of Computer Engineering, SES’s R. C. Patel Institute of Technology, Shirpur, India

Abstract:--
Nowadays the Internet is part of life because of any information is easily available on the

Internet. It has a large size of information; hence the high efficiency and get relevant information are
challenging issue due to the changing nature of the deep web. As crawler plays important role in such
cases. So we proposed such crawler which provides efficient and extracts relevant information from web.
The smart crawler contains two-phases as site locating and in-site exploring. We developed smart crawler
using K-means clustering methods. Clustering makes a group of similar data items known as clusters.
Here we describe K-means clustering techniques. The most famous clustering method is K-means
methods which divide data items in K clusters and provide better result with high efficiency. Also we
compare the result of existing system and smart crawler using K-means provide an efficient harvesting
rate of deep websites within the least amount of time. .

Keywords:-
Deep Sites, SCDI, ACHE, Crawler, K-means, URLsS
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Simulation of Special Mathematical Functions

Sangeeth Sadanand, Department of Electronics Engineering, Ramrao Adik Institute of Technology, Nerul, Navi, Mumbai

Divya K. Shah, Department of Electronics Engineering, Ramrao Adik Institute of Technology, Nerul, Navi, Mumbai.

Vishwesh A. Vyawahare , Department of Electronics Engineering, Ramrao Adik Institute of Technology, Nerul, Navi, Mumbai.

Abstract:--

Fractional order system is extensively studied over past few decades. Many simulation and

implementation studies have proved that the fractional-order (FO) systems are better

than the

conventional integer-order systems in terms closed-loop performance. Special mathematical function is
unavoidable in most of the solution of fractional order calculus. Computation of these functions requires a
large memory and computational resource. Real time calculation is required to speed up performance of
a fractional order System. In this work an attempt to simulate the computation of Gamma function, Error
function and Complementary error function using ModelSim is made. This work also presents

computational error..
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Design of Area and Power Optimization Shift Register

Akshata G. Shete, Dept. of Electronics and Telecommunication Engg. D. Y. Patil College of Engineering, Akurdi Pune, India

Aarti Gaikwad, Dept. of Electronics and Telecommunication Engg. D. Y. Patil College of Engineering, Akurdi Pune, India

Abstract:--

This paper describes new technique for area and power evaluation 6T latch for shift register. In
this technique area and power optimized by using pulsed latch instead of flip flop. Pulsed latch causes the
timing problem which is overlapped in conventional single pulse clock. Here we are using non-
overlapped delayed clock signal to solve this problem. The advanced portable devices require area and
power efficient devices. The design is implemented with 65nm technology in Micro wind EDA
(Electronic Design Automation) Tool. A n-bit shift register using pulsed latches is designed. The
simulation results show that the proposed shift register design with less transistor count is better choice

for low power and area efficient applications.

Keywords:-
Area-Efficient, flip-flop, pulsed clock, pulsed latch, shift register.
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Performance Analysis of a Grid Tie Voltage Source
Inverter based Photovoltaic System

G.A.Sadaphal , pG student
Prof.S.T.Gaikwad. , Associate Professor

Abstract:--

The grid connected photovoltaic (PV) system is one of the most encouraging renewable energy solutions
available today, it gives many benefits to the end users and the utility network. Due to the weather
dependencies the large scale integration of distributed generation (DG) has created challenges for the
network operator. The PV cells are expansively used for distribution level as a DG. MPPT technique
increases the power output of PV cell and also its life. The photovoltaic generation is a dc current source
connected to the utility grid through power electronic interfacing devices. The load pattern and solar
irradiations on a PV system consider is of teaching institute under study. The actual output of PV array
system in real life is compared with the output of simulation results. The main contribution of this paper
is to provide appropriate current control, when PV system is connected to grid. Two different
configurations such as 110kW and 65-45kW grid connected PV systems are presented and simulated in
MATLAB/SIMULINK environment. Both the systems are tested under variable load conditions with
distributed load and are analyzed based on their output results.

Index Terms:--
Photovoltaic Cell, current controller, maximum power point tracker, voltage source inverter
(VSI), transformer, distributed generation..
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A Novel Approach for Image Security

Jyoti T. G. Kankonkar. y Department of Computer Engineering, Goa College Of Engineering, Goa,

Nitesh Naik. y Department of Computer Engineering, Goa College Of Engineering, Goa

Abstract:--

Image security is a major concern as the digital communication and digital data is growing
rapidly. Image data is generated in loads every day. We need faster and robust mechanisms to secure the
image data. Images consist of a lots of information to be processed. Encryption algorithms already
existing works better for textual data. Hence there is a need for novel techniques for secure image data
communications. Various fields such as military scopes, security firms, social network etc. need systems
that can protect the images while communicating and data transfers. In this paper the proposed idea
involves use of image encryption using chaotic approach with a combination of image stitching
mechanism. This unique combination provides double layered protection to the images. In order to
transfer an image, the image is first partitioned, encrypted and then transferred making it difficult for
attackers to access the whole image. On the other end, the encrypted image is decrypted using a
symmetric key generated using chaotic approach that uses logistic map function and linear feedback shift
register which is followed by image stitching procedure. The overall proposed system provide security to
the image data to be transferred. The digital communication within the system will be partitioned and
encrypted providing security against attacks. Only the receiver with correct key and all the encrypted
parts will be able to successfully generate the original image. The use of chaotic technique for encryption
along with image stitching after decryption will make it difficult for the trespasser to have access to the
original image..

Keywords:-
Image encryption, Image stitching, Logistic Map function, Linear feedback shift register.
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Hybrid technique of Image Encryption to Enhance
Security

Kalyani D. Kadukar., student of M.Tech.(CSE), R.C.E.R.T, Chandrapur, India
Prof.R. Krishna.,, Department (CSE), R.C.E.R.T, Chandrapur, India

Abstract:--

The aim of this project is related to novel scheme for separable reversible data hiding in
encrypted image is proposed, which consists of image encryption, data embedding and data-
extraction/image-recovery ,3D chaos generation,3D histogram equalization, row rotation, column rotation
and XOR operation phases. Additional message are embed into some cover media, such as military or
medical images, in a reversible manner so that the original cover content can be perfectly restored after
extraction of the hidden message is called reversible data hiding. Separable reversible data hiding, the
name its self indicates that it is a separable reversible data technique .That is it is reversible data technique
but which is separable. The separable means which is able to separate .The separation of activities i.e.
extraction of original cover image and extraction of payload is done in this method. This separation
requires some basic cause to occur. In separable data hiding key explained by Xinpeng Zhang the
separation exists according to keys. Digital images has increased rapidly on the Internet. Security
becomes increasingly important for many applications, confidential transmission, video surveillance,
military and medical applications. The transmission of images is a daily routine and it is necessary to find
an efficient way to transmit them over networks. The project will be called as hybrid technique because it
consists of two methods of encryption method, in 1st method image encryption ,data embedding and data
extraction steps will be held. In 2nd method 3D chaos generation,3D histogram equalization, row rotation,
column rotation and XOR operation will be held. The project will work such that the input to 1st method
will take any data which will be encrypted in this method and then the output of this method will be taken
as input to the 2nd method. So, we will get the more encrypted data..

Keywords:-
Encryption,3D chaos method ,Data embedding ,Decryption
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Health Care in Smart Cities: A Survey based on IoT data
analytics

Swapnaja Rajeshb Hiray, PhD Scholar ,Department Of Computer Engineering, GITAM University, Visakhahpattanam
Dr. Brahmaramba Ravi , Associate Professor,Department of Information Technology, GITAM University, Visakhahpattanam

Abstract:--

The global population continues to grow at a steady pace, and more people are moving
to cities every single day. Concept of Smart City is not new, but application of data analytic techniques
and improving performance of Smart city application needs focus. The first cut idea of Smart city is a
city, where ICT( Information and Communication Technology) can be used to solve social problems .
We can view the Smart city as an integrated living solution that links many life aspects such as power,
transportation, buildings, public security and emergency solutions, city governance, waste and water
management and healthcare in a smart and efficient manner to improve the quality of life for the citizens .
Smart city applications basically involves pervasive and ubiquitous environment and Internet of Things
can make it possible. This environment itself produces ‘BIG DATA’. Data analytics in healthcare
system mainly carried out in two categories Clinical applications and Non clinical applications. In this
paper we studied basically Smart city Healthcare applications and data analysis issues related to this. We
have developed one prototype smart city application to conceptualize the problem. Outcome of this
survey is to summarize methods used for smart healthcare data analysis and issues related to it. These
instructions give you guidelines for preparing papers for the International conference ICCSE). Use this
document as a template if you are using Microsoft Office Word 6.0 or later. Otherwise, use this document
as an instruction set. The electronic file of your paper will be formatted further at International Journal of
Computer Theory and Engineering. Define all symbols used in the abstract. Do not cite references in the
abstract. Do not delete the blank line immediately above the abstract; it sets the footnote at the bottom of
this column.

Keyword—
Big Data, , Healthcare applications, Internet Of Things, Predictive analysis, Smart City.
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Malicious Misbehavior Activity Detection Using
Probabilistic Threat Propagation in Network Security

Tejaswini S. Akulwar, Student of M.tech.(CSE)R.C.E.R.T Chandrapur, India

Abstract:--

A PTP approach in network security for misbehavior detection system present a method for
detecting malicious misbehavior activity within networks. Along with the detection, it also blocks the
malicious system within the network and adds it to Blacklist. Malicious node defined as a compromised
machine within the network that performs the task provided by i.e. it does not forward the legitimate
message to another node in the network or sends some other message to a neighbor node. This system is
based on Probabilistic threat propagation. This scheme is used in graph analysis for community detection.
The proposed system enhances the prior community detection work by propagating threat probabilities
across graph nodes. To demonstrate Probabilistic Threat Propagation (PTP) considers the task of
detecting malicious node in the network. Proposed System also shows the relationship between PTP and
loopy belief propagatio
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Virtualization Concept and Live Virtual Machine
Migration
Divya Kapil, School of Computing, Graphic Era Hill University,Dehradun, India

Abstract:--

Virtualization technology was invented to maximize the utilization of hardware resource by IBM
in 1960s. Virtualization is the abstraction of the physical resources needed to complete a request and
underlying hardware used to provide service. It splits up a physical machine into several virtual machines.
A virtual machine can be defined as, “It is a software implementation of a computing environment in
which an operating system or application can be installed and run. As hardware cost went down, the need
for virtualization faded out. More recently, virtualization become important again to improve availability,
security, cost reducing, reliability and flexibility. This paper describes Virtualization technology concept.
And also a case study on live virtual machine migration is used to explain the points.
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Efficient Design of a Reconfigurable FIR Filter using
Distributed Arithmetic for FPGA Implementation

Reshma Ghu rde, Dept. of Electronics and Telecommunication Engg D. Y. Patil College of Engineering, Akurdi Pune, India
Mrs. Aparna Shinde, Dept. of Electronics and Telecommunication Engg D. Y. Patil College of Engineering, Akurdi Pune, India

Abstract:--

This paper present Distributed Arithmetic (DA) Algorithm for high-throughput reconfigurable
implementation of an FIR Filter. When we directly applied the DA algorithm to FPGA for realization of
an FIR filter, it is difficult to achieve the best configuration in the coefficient of FIR filter, the storage
resource and the computing speed. For the FPGA implementation, the Dual-Port Distributed RAM based
lookup table (LUT) are required for Reconfigurable FIR Filter. Registers are required to store the result of
partial inner products of different bit positions for DA processing, but here registers are shared by the DA
units for bit slices of different weightage.

Index Terms:--
Distributed arithmetic, finite-impulse response (FIR) filters, reconfigurable implementation,
lookup-table (LUT).
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Conversion and Recognition of Handwritten Devanagari
Character String into Printed Character String Using K-
Nearest Neighbourhood (KNN) Algorithm

Sushma Dipakrao Pilawan, Department of Electronics, SGGSIE&T, Nanded 431606, India
Prof. Milind V. Bhalerao, Department of Electronics, SGGSIE&T, Nanded 431606, India
Dr. Abhijeet V. Nandedkar, Department of Electronics, SGGSIE&T, Nanded 431606, India

Abstract:--

This paper presents a system for the conversion of handwritten string of devnagari character to
printend character string by using character segmentation approach. 11 different statistical features of
segmented characters are extracted which are compared with features extracted from printed string of
characters available in training data for cross validation purpose using K- nearest neighbourhood (KNN)
algorithm. Use of handwritten string of devnagari character written in different styles and converting it
into printed string makes the system more prone to real life application.System mainly works on
segmentation of characters using bounding box, after segmentation features are extracted which is
compared with training feature set. We have analysed our system with existing devanagari handwritten
character recognition system. In given framework, we have focussed on a creating database in different
styles and recognising them as printed characters..

Keywords:--

K- Nearest Neighbourhood Algorithm, Connected Components Labeling, Bounding Bob,
Statistical Feature, Feature Extraction Technique, Handwritten Devnagari string segmentation, Object
extraction, Printed String of Characters..
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Dynamic MCQ Generation From Ontology

Yugandhara Yeotikar, Department of Information Technology ,SGGSIE&T, Nanded, India

Abstract:--

Ontologies are knowledge representation structures which can be used as a platform for building
many intelligent applications like educational applications. This knowledge represented in the form of
individuals, classes, properties, and the relationship between classes and individuals.This knowledge can
be used by an assessment system in the form of multiple choice questions (MCQs). The existing
approaches produce simple analogy type question.There is no use of the terminological axioms in the
ontology such as existential, universal and cardinality restrictions on concepts and roles for MCQ
generation and improper ways of generating distracters. We introduce two approaches to generate MCQ
along with the proper distractor and key, which generates MCQs that are very useful and realistic in
conducting assessment tests, and Our distractor generation techniques, unlike other methods, consider
Open World Assumption, so that the generated MCQs will be always precise by ensuring falsity of
distracting answers. Implementation and experiments carried on specific Ontologies by using proposed
systems have shown the effectiveness of the approaches

Keywords:--
Web Ontology Language, Semantic web, Assessment Systems, Dynamic Multiple choice
guestions generation
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Coexistence of Zigbee with 802.11n

Prerana Dhanaraj Mahajan., Dept. of Electronics and Telecommunication, Vidyalankar Institute of Technology, Wadala
Mumbai, India

Shraddha Panbude., Dept. of Electronics, Vidyalankar Institute of Technology, Wadala Mumbai, India

Abstract:--

Wireless technologies are essential and important part of today’s world. Zigbee technology is one
of them and getting more popularity due to its advantages like low power and low-cost reliability. It is
operated on 2.4 GHz industrial scientific and medical band. On the same band, there is another standard
which is 802.11n wifi standard is also operated. When both the technologies coexist together then there is
interference occurs. As data rate of zigbee is very less compared to the wifi impact of interference is more
on zigbee technology. In this work new features of channel bonding, frame aggregation and multiple
input multiple output (MIMO) is applied to the 802.11n and effect of 802.11n on zigbee technology is
measured using different performance metrics packet delivery ratio(PDR), bit error rate (BER), control
overhead and throughput.

Keywords:--
Zigbee, 802.11n, coexistence

25— 26" July 2017 ICUC -17 ISBN: 978-81-932966-2-2

Organized by:
Sinhgad College of Engineering , Pune
and
Institute For Engineering Research and Publication (IFERP)
Page | 64




International Conference on Ubiquitous Computing

Pune, Maharashtra on 25" — 26" July 2017

Estimation of Very Fast Transient Overvoltage’s in GIS

Prof. Rupali. A. Ahire., Electrical Engineering Department, K.K.Wagh IEE&R, Nashik
Rahul S. Patil., CG Power and Industrial Solutions Ltd., Nashik

Abstract:--

Very fast transient over voltages (VFTO) arise within a GIS whenever there is an instantaneous
change in voltage. Most often this change occurs as a result of opening or closing of disconnector switch
(DS). Other events, such as the operation of circuit breaker, the occurrence of a line-ground fault or the
closing of grounding switch can also cause VFTO. However, during a DS operation a number of re-
strikes and pre-strikes occur due to the low operating speed of DS compared to a circuit breaker.
Therefore DS switching is main source of generating VFTO. The transients are characterized by their
short duration and very high frequencies. The rise times are in the range of ns, with dominant frequency
components up to 100MHz. The generation and propagation of VFT from their original location
throughout GIS can produce internal and external over voltages, the multiple refractions and reflections of
these surges at impedance discontinuities within the enclosures create complex waveforms, which
depends on the disconnector design, the operating conditions and external substation configuration. The
main concern are internal over voltages between conductor and the enclosure. Internal VFTO cause high
stress of the insulation system. VFTO in GIS are of greater concern at the highest rated voltages, for
which the ratio of the lightning impulse withstand voltage (LIWV) to the system voltage is lower. As the
rated voltage increases, the difference between the rated lightning impulse withstand voltage and the
VFTO decreases. Hence, VFTO can become the limiting dielectric stress which defines the dimensions in
certain cases. VFTO simulation is a well-known instrument for the calculation of over voltages needed for
the insulation co-ordination process. This paper describes the Estimation of VFTO due to variation in the
GIS parameters.
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Iris Classification Based on K-SVD Dictionary Learning
Algorithm

Atul Pagare., Department of Information Technology ,SGGSIE&T, Nanded, India

Abstract:--

Biometric authentication system is essentially deals with pattern recognition all biometric
authentication system must be unique small error in authentication affect on overall accuracy of system.
When any biometric data runs into large scale then classification time complexity is increases to deal with
time complexity in recent year there has been lots of development in sparse representation of signal. It
gives linear combination of image signals. Sparse representation enables feature extraction, regularization
of inverted problem and more. Decomposing the image signal to fit into dictionary by using any pursuit
algorithm is new emerging activity in signal processing. This paper introduces classification of human iris
using iterative K-SVD. It is flexible with any pursuit method. We analyze K-SVD and demonstrate it with
iris dataset. Uniqueness of iris used to create authenticated system where accuracy of classification is very
necessary. Predefined iris classes used to for faster retrieval of identities. It’s also helpful to identify
duplicate entries in data based on unique fiber structures of iris images. UPOL is standard iris database is
used for experiment.

Keywords:--
Biometrics, Iris fibers, Iris classification, K-SVD, Sparse represntation, Dictionary learninig,
Atom decomposition
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Design and Analysis of Soft Error in Combinational
Circuits Using NOR Gate

Poonam S.Wan khede., P.G. Student, Department of E & Tc Engineering, DYPCOE Akurdi,Pune.Maharashtra, India
Prof.Mrs.Usha Jadhav., Assistant Professor, Department of E & Tc Engineering, DYPCOE Akurdi,Pune.Maharashtra, India

Abstract:--

As the model technology is being scaled down, physical defects occur.Physical defects are those
that can occur in a circuit. During fabrication of chip many types of imperfection can occur, for example,
breaks in signal lines, lines shorted. Soft Error are not the permanent error’s, they only occur for some
time period in a circuit. The soft error’s can be resolve by using fault detection techniques. Stuck-at-fault
is one of the fault detection technique, the stuck-at-fault is an logical type detection. This paper attempts
to reduce the soft error from circuit. The Proposed technique is based on stuck-at-fault in NOR gate for
two condition’s 1i.e stuck-at-0 and stuck-at-1 in circuit.

Keywords:--
Soft error, stuck-at-faults, tolerate, probability of failure, masking factors.
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North Indian Raga Recognition using SVM classifier,

MFCC and Pitch features

Raj akamal S. Zanke., Department of Electronics SGGSIE and T Nanded, India
Dr. D. D. Doye., Department of Electronics SGGSIE and T Nanded, India
Dr. L. V. Birgale., Department of Electronics SGGSIE and T Nanded, India

Abstract:--

The objective of the Raga recognition is to recognize the correct raga for both the known and
unseen cases using the SVM Classifier, MFCC and Pitch features. Here in this paper it is presented that
there is the recognition for un-trained dataset is also have the good accuracy. Training & Testing is done
on the 30 sec audio clip of the Raga. The dataset of the North Indian Classical Raga is created having 10
to 12 clips for each raga in the training phase. The audio clip of raga is down sampled at 11025 Hz. The
MFCC & the pitch features are extracted from the input audio sample of the Raga. The features extracted
is then used to distinguish between the different Ragas using SVM Classifier. The Raga recognition is
done with matching the features with the train dataset. Direct Film songs can be recognized with a more
advancement of this System which will be more helpful in the music information retrieval system which

in turn will be beneficial to the music learner.

Keywords:--
Raga Recognition, SVM Classifier, MFCC and Pitch Features.
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Analysis of Similarity Measure for Text Processing

Tulaja., SGGSIE &T, Nanded, Maharashtra

Abstract:--

Computing the similarity between two documents is one technique in text processing field. The
feature with larger spread offers more contribution to the similarity between documents. The similarity
measure is used in web search engine. This paper compares the existing similarity measure with F-
measure for analysis of accuracy in document clustering and classification algorithm. Through which we
show the existing measure is better than other measure. F-measure is combination of precision and recall
with N number of documents. The SMTP measure takes into below condition, the same content looks in
both documents, the same content looks in only one documents, the same content looks in none of the
documents. This measure is extended to used to calculate the similarity between two sets of documents.
The higher value of F-measure indicates the good document clustering. The effect of this measure is
performed on two data sets for text categorization and clustering problem. The results calculated in this
paper are better than the previously existing methods
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Development of Computer Aided Diagnosis System
(CADx) for Detection  of Anomalies in Breast using
Textural Features with PNN classifier

Miss. Ankita Satyend ra Singh., Department of Electronics and Telecommunication Engineering SVERI’s COE Pandharpur,
Solapur Mabharashtra, India

Prof. Mrs. M. M. Pawar., Department of Electronics and Telecommunication Engineering SVERI’s COE Pandharpur, Solapur
Maharashtra, India

Abstract:--

High False Negative Rate (FNR) is a very significant problem in a Computer Aided Diagnostic
System as false negative answer may lead to a very high increase in the number of deaths. The main aim
of this paper lies in the development of a new Computer Aided Diagnosis (CADX) system for the proper
identification of breast masses. It also focuses at extraction of textural features. The input images are pre-
processed by using Adaptive Median Filter and then segmented by using Gaussian Mixture Model i.e.
GMM segmentation and further are subjected to feature extraction, selection and finally classification by
using PNN classifier. MIAS database is used for research purpose which contains 322 mammogram
images out of which 60 images as 20 of benign, 20 malignant and 20 normal are taken into consideration
for feature extraction. 22 texture features are extracted and are further classified. PNN classifier with 80-
20 train-test partition is used for classification. The Sensitivity, Specificity and Accuracy obtained by the
selected features are 100%, 100%, and 100% respectively.

Keywords:--
Mammogram, Pre-processing, Adaptive Median Filter ,Gaussian Mixture Model (GMM), EM
algorithm, MAP algorithm, Image segmentation, Texture features, Classification, PNN classifier.
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A Robust And Reversible Watermarking Scheme For
Relational Data

SunitaNaIIamadge., Department of Information Technology, Shri Guru GobindSinghji Institute of Engineering and Technology,
Nanded, India

Prof. R. S. Potpelwar., Department of Information Technology, Shri Guru GobindSinghji Institute of Engineering and Technology,
Nanded, India

Abstract:--

In this paper, a robust and semi-daze reversible watermarking (RRW) strategy for numerical
social info has been prompt that addresses the on top of targets. take a look at examines demonstrate the
viability of RRW against pernicious assaults and demonstrate that the projected procedure beats existing
ones progression in info advancement is expecting a growing half within the usage of data structures
containing social databases. Watermarking is upheld to authorize possession rights over shared social info
and for giving how to handling info fixing. At the purpose once possession rights ar enforced utilizing
watermarking, the essential info experiences sure adjustments; so of that, the data quality gets bargained.
Reversible watermarking is used to ensure info quality aboard info recovery. In any case, such systems ar
usually not vigorous against vesicatory assaults and do not offer any instrument to specifically watermark
{a specificlaselectedjahalficular} characteristic by considering its part in learning revelation. during this
manner, reversible watermarking is needed that guarantees; initial, watermark encryption and translating
by representing the a part of the sizeable range of parts in info revelation; and,second, distinctive info
recovery at intervals the sight of dynamic malignant assaults.

Keywords:--
Reversible watermarking, genetic algorithm, data recovery, numerical data
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Online  Signature  Verification For  Personal
Authentication

Miss. KalyaniVij aysinhGidde., Department of Electronics and Telecommunication Engineering SVERI’s COE Pandharpur,
Solapur Maharashtra, India

Prof. Ms.J.A.Kendule., Department of Electronics and Telecommunication Engineering SVERDI’s COE Pandharpur, Solapur
Maharashtra, India

Abstract:--

Signature is a behavioral biometric: it is not based on the physical properties, such as fingerprint
or face, of the individual, but behavioral ones. Signature verification is split into two according to the
available data in the input. Offline (static) signature verification takes as input the image of a signature
and is useful in automatic verification of signatures found on bank checks and documents. Online
(dynamic) signature verification uses signatures that are captured by pressure-sensitive tablets that extract
dynamic properties of a signature in addition to its shape. The paper presents online signature verification
on touch interface mobile devices for personal identification and authentication. The proposed system
uses set of attributes such as x, y coordinates and pressure of all signature points of each user as an input.
An online signature is represented by a set of histograms. These histogram features are designed to get
essential attributes of the signature as well as relationships between these attributes. These set of
histograms are widely used as a feature set to capture attribute statistics in recognition process. The
feature extraction will begin by converting Cartesian coordinates to polar coordinates and deriving
positional invariant features from those attributes. At last output is compared the existing method with
SVM classifier.
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Li-Fi: Audio and Data Communication using Visible
Light

Miss. PSShlnde, (Electronics & Telecommunication, SVERI’s College of Engineering, Pandharpur, India)
Prof. Miss. J.A.Kendu |e., (Electronics & Telecommunication, SVERI’s College of Engineering, Pandharpur, India)

Abstract:--

Because of the huge growth in the number of mobile phones subscriptions in recent times, over
the past few years there has been a rapid growth in the utilization of the RF region of the electromagnetic
spectrum. This has been causing a rapid reduction in free spectrum for future devices. Light-fidelity (Li-
Fi) operates in the visible light spectrum of the electromagnetic spectrum i.e. it uses visible light as a
medium of transmission rather than the traditional radio waves. Li-Fi stands for Light-Fidelity. Li-Fi is
transmission of data using visible light by sending data through an LED light that varies in intensity faster
than the human eye can follow.This paper discuss the implementation of the basic Li-Fi based system to
transmit audio signal and serial data from one device to another through visible light. This model will
demonstrate how the notion of one-way communication via visible light works, in which Light emitting
diode (LED) used as the light source or transmitter. The model will transmit digital signal via direct
modulation of the light. The emitted light will be detected by receiver.By using visible light as
transmission medium, Li-Fi provides wireless indoor communication. Dr. Herald Haas, the professor of
mobile communications at the University of Edinburgh School of engineering, first time publically
displayed the proof of Light Fidelity (Li-Fi), a method of Visible Light communication (VLC).

Keywords:--
Li-Fi  (Light-Fidelity), LED (Light Emitting Diode), LDR (Light Dependent
Resistor),Microcontroller, Audio Power Amplifier
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Pomegranate Leaf Disease Detection Using Image
Processing with Support Vector Machine Classifier

Miss. T. N.Shai kh, (Electronics & Telecommunication, SVERI’s College of Engineering, Pandharpur, India)
Dr.S. M. Mu kane., (Electronics & Telecommunication, SVERI’s College of Engineering, Pandharpur, India)

Abstract:--

India is an agricultural country where most peoples in the India are farmers. Economically
agricultural field is very much important. The crops are affected by uneven climatic conditions, Because
of that diseases on plant is increased and agriculture yield is decreased. Which restrict the growth of plant
and quality and quantity of plant also reduces. Now days, the conditions become worst because of
bacterial diseases. Detection of diseases and prevention is much more needed for that modern agriculture
techniques and systems are designed.The studies of the pomegranate plant diseases mean the studies of
visually observable patterns seen on the plant. It is very difficult to monitor the pomegranate plant
diseases manually. Hence, image processing is used for the detection of pomegranate plant diseases.
Image processing is best way for detecting and diagnosis the diseases. Disease detection involves the
steps like image acquisition, image pre-processing, image segmentation, feature extraction and
classification. K-means clustering algorithm is used for segmentation and support vector machine is used
for classification of disease.

Keywords:--
Image Processing, K-means Clustering, Segmentation, SVM (Support Vector Machine),

Classification, Disease Detection, Feature Extraction.
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BLE Based Automatic Attendance System

Niranjan N. Shinde., RamraoAdik Institute Of Technology, Nerul,Navi Mumbai
Ashwini A.Raorane., RamraoAdik Institute Of Technology,Nerul,Navi Mumbai

Abstract:--

Generally attendance is a really difficult task for both students and teachers. The system needs lot
of paperwork which is hard to handle and can be altered or misplaced. The ‘BLE Based Attendance
System’ will work using smartphones and psocble device, to directly register your attendance on a master
computer or college server so, it’s done without any disturbance and wasting of time and paper and
human efforts. In this project, when we walk into classroom with turned on Bluetooth and enter into
classroom, our attendance is directly registered on system automatically. This can be achieved as,when
teacher enters in classroom they turn on psocto take attendance. The board will check for available ble
devices in the classroom through registered UUID’s(unique addresses provided to every Bluetooth device
) of students phones to their specific names/roll no. In this whole scenario students will have to just turn
on the Bluetooth on their phone. After this process the attendance will be uploaded on server for further
use. The system will give us output in a log which can be further utilised for calculating total attendance,
defaulters, etc. Bluetooth Low Energy (BLE), also is known as Bluetooth Smart—a marketing name for
low-powered Bluetoothdevices. Bluetooth is one of the most widely used short-range wireless technology
including large number of mobile phones and other portable devices. This technology is used with loT
(Internet of Things) gives us multiple options for various applications, one of which is education and with
our education system, attendance is major part. So overall this system provides a secure and user friendly
approach to a time consuming system.

Keywords:--
BLE, Bluetooth,UUID’s, IOT, PSoC, Server.
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Performance Analysis of physical layer in LTE

Neha Narudkar., Dept. of Electronics Engineering Ramrao Adik Institute Of Technology,Nerul,.
Tej asvini Nai k., Dept. of Electronics Engineering Ramrao Adik Institute Of Technology,Nerul,.
Vaishali S. Jad hav., Dept. of Electronics Engineering Ramrao Adik Institute Of Technology,Nerul,.
Dr. Uttam Kolekar., principal, A.P. Shah Institute of Technology, Thane,

Abstract:--

Long Term Evolution (LTE) is an advanced standard technology of the mobile communication
systems. LTE has been developed by the 3rd Generation Partnership Project (3GPP). The new features
exhibited by this technology is a direct impact of applying new modulation and coding techniques such as
the Orthogonal Frequency Division Multiplexing (OFDM) for the Downlink and the Single Carrier
Frequency Division Multiple Access (SC-FDMA) for the Uplink. It is observed that throughput is
increased. Overall performance is improved, QoS is also improved.
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BLE Based Automatic Attendance System using PsoC
BLE

Niranj an Shinde., Electronics Engineering Ramrao Adik Institute of Technology Nerul, Navi Mumbai
Ashwini Raorane., Electronics Engineering Ramrao Adik Institute of Technology Nerul, Navi Mumbai

Abstract:--

Bluetooth 4.0 named Bluetooth Low Energy (BLE) has low-powered Bluetooth devices.
Bluetooth is one of the most widely used wireless technology including large number of mobile phones
and other portable devices. This technology is used with 10T (Internet of Things) gives usmultiple options
for various applications, one of which is education and, attendance system is integral part of education
system. The conventional attendance system has so many difficulties. In ‘BLE Based Attendance System’
project, when students walk into classroom with turned on Bluetooth and enter into classroom, attendance
is directly registered on system automatically. This can be achieved as; when teacher enters in classroom
they turn on PSoC to take attendance. The board will scan for available BLE devices in the classroom
through registered UUIDs (unique addresses provided to every Bluetooth device) of students phones to
their specific names/roll no. In this whole scenario students will have to just turn on the Bluetooth on their
phone. After this process the attendance will be uploaded on network host (PC, Server, etc.) for further
use. The system will give us output in a log which can be further utilized for calculating total attendance,
defaulters, etc. So overall this system provides a secure and user friendly approach to a time consuming
system.

Keywords:--
BLE, Bluetooth, UUIDs, lIoT, PSoC, Server.
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